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CAUTION

In This Manual

This document is the self-paced training manual to help you to understand what is Agilent
B1500A, what functions the B1500A has, how to use the B1500A, and what applications
the B1500A contributes to.

The test setup data described in this manual are only examples. If these example data
damage your devices, Agilent is NOT LIABLE for the damage.
* Module 1. Introduction

This module explains the product concept and the key features of the B1500A/
EasyEXPERT. You will learn about what is the B1500A.

e Module 2. Getting Started

This module explains the basic operations of the B1500A. You will learn about how to
launch B1500A/EasyEXPERT and how to perform application test and quick test.

e Module 3. Data Display and Management

This module explains the data display and analysis capabilities of the EasyEXPERT
software. You will learn how to use analysistools, how to change display setup, and
how to print/export test result data.

* Module 4. Classic Test Environment

This module explains the classic test mode of the EasyEXPERT. You will learn how to
create the classic test setup in the course exercises.

* Module5. Basic Measurement

This module explains the basic I-V sweep measurement function and the cabling and
fixturing issues. You will learn how to measure |-V curvesin the course exercises.

* Module 6. Low Current Measurement

This module explains the low current measurement technique. You will learn how to
measure the low current in the course exercises.

* Module 7. Measurement Functions

This modul e explains the measurement functions available with the B1500A. You will
learn how to use various measurement functions in the course exercises.

e Maodule 8. Capacitance M easurement

This module explains the capacitance measurement function. You will learn how to
measure the capacitance in a course exercise.

e Module 9. Modifying Application Test Definitions

This modul e explains amodification example of an application test definition. You will
learn how to modify the definition in a course exercise.

e Module 10. Creating Your Test Definitions

This module explains about the application test definition. You will learn how to create
your application test definition in a course exercise.



e Module 11. Advanced Definitions and Operations

This modul e explains how to control external GPIB devices, how to call an execution
file, how to perform arepeat measurement, and how to use the prober control script.

e Module 12. Miscellaneous Operations

This module explains what is the status indicator, what is the automatic data export
function and the automatic data record function, how to perform selftest and
calibration, how to perform SMU zero offset cancel, and such.

e Module 13. SPGU Control and Applications

This modul e explains the SPGU Control classic test. You will learn how to create the
classic test setup and the applications using SPGU in the course exercises.

EasyEXPERT is atrademark of Agilent Technologies. All other trademarks are the
property of their respective owners.



Class Exercises

Class exercises use the test setup listed below. The test setup data are only examples and
included in the Demo.xpg file stored in the Manual CD-ROM.

Module Exercise Device Test setup/definition/data Page
Module 1 No exercise
Module 2 |d-Vd measurement MOSFET | CMOS: I1d-vd 2-19, 27
Id-Vg, gm-V g measurement MOSFET | CMOS: Vth gmMax 2-19, 27
B2200/E5250 switch control - - 2-32
Module 3 Id-Vg, gm-V g measurement MOSFET | GMMAX.xtr 3-28
Using Preview window - - 3-31
Module 4 |d-Vd measurement MOSFET | Trngld-Vd 4-25
Multi Channel I/V Sweep Bipolar Tr | Trng Mullti 4-37
M easurement LED
I/V List Sweep Measurement MOSFET | Trng List 4-51
[/V-t sampling measurement 0.1puF Trng Sampling 4-64
C-V sweep measurement MOSFET | Trng CV 4-76
B2200/E5250 switch control - Trng Switch 4-81
Direct Control (C-f measurement) 0.1puF Trng C-f 4-88
Module 5 |d-Vd measurement MOSFET | IDVD, Id-Vd 5-7
SMU series connection 511 kohm | IRVR 5-24
SMU parallel connection 1 ohm Parallel 5-28
Re measurement, kelvin connection | Bipolar Tr | REKELV 5-38
Module 6 Leak current measurement - Zero-check 6-9
Ultralow current measurement - Zero-check-ASU 6-19
|d-V g measurement MOSFET | IDVG 6-20
Gummel plot Bipolar Tr | GUMMEL 6-25
Module 7 SMU pulse mode MOSFET | IDVD-Pulse 7-8
RC measurement 0.1 uFand | RC-sampling-log 7-16
511 kohm
Negative hold time 511 kohm | R-sampl-neg-hold 7-22
Auto analysis MOSFET GMMAX 7-28
Bias hold function LED LED 7-35
SMU series resistor 511 kohm | 1V-res 7-43




Module Exercise Device Test setup/definition/data Page
Module 8 C-V sweep measurement MOSFET | CV-1MHz 8-6
Module 9 Modifying application test MOSFET | Trngldvd Vth.xtd 9-14

definition Trng idvd idvg2.xtd 9-29
Trng idvd idvg3.xtd 9-32
Using auto analysystwice MOSFET | VthgmMax and Id 9-34
Using vector data MOSFET | Trng Cgg-Vg 9-42
Module 10 | Creating application test definition MOSFET | Trngidvd idvg.xtd 10-17
Module11 | no exercise
Module 12 | no exercise
Module 13 | Charge pumping MOSFET | Charge Pumping 4T 0.1V 13-20
step
Flash memory MOSFET | Demo-S-NorFlash 13-29
Endurance
ALWG output 511 kohm | ALWG monitor 13-36
NOTE Demo.xpg file
Demo.xpg fileisrequired to create the Demo preset group which contains the test setup
data used by the class exercises. And it is stored in the \data folder on the Agilent B1500A
Manual CD-ROM, Edition 4 or later.
The Demo preset group should be created before starting the class exercise. To create the
preset group, launch EasyEXPERT and import the file by using the Preset Group Import
dialog box opened by clicking My Favorite Setup > Preset Group > Import Preset Group.
The test setup data are only examples for the class exercises.
NOTE xtd files
The\data folder on the Manual CD-ROM stores some .xtd files. They are the application
test definitions used by some class exercises. To use the definition file, import the file by
using the Test Definition Import dialog box opened by clicking Library > Import Test
Definition. The test definition data are only examples for the class exercises.
NOTE Xtr files

The\data folder on the Manual CD-ROM stores some .xtr files. They are the sample test
results created by executing the test setup which has the same name as the result data. To
display these sample test results, import the files by using the Test Result Import dialog
box opened by clicking Results > Transport Data > Import.



Test Setup for Class Exercises

The Demo preset group containsthe following test setup. The setup data are only examples
for the class exercises. The following table lists the test setup name in a phabetical order.

Test Setup Name

Description

ALWG monitor 511 kohm sampling measurement with SPGU ALWG output
Charge Pumping 4T | MOSFET Icp-Vbase measurement

0.1V step

CV-1MHz MOSFET Cgs-Vg measurement

Demo-S-NorFlash
Endurance

MOSFET Endurance test

Fowler-Nordheim

Fowler-Nordheim (FN) plot

GMMAX MOSFET sgrt_Id-Vg, PEAK-V g measurement

GUMMEL Bipolar transistor gummel plot

IDVD MOSFET Id-Vd measurement

IDVD-Pulse MOSFET pulsed 1d-Vd measurement

Id-vd MOSFET Id-Vd measurement, Application Test

IDVG MOSFET Id-Vg measurement

IRVR 511 kohm |-V measurement

IV-res 511 kohm |-V measurement with SMU series resistor

LED LED |-V measurement

Parallel 1 ohm I-V measurement, voltage force and current measurement
PG monitor 511 kohm sampling measurement with SPGU VPUL SE output
RC-sampling-log RC sampling measurement, log sampling

REKELV Bipolar transistor Re measurement

R-sampl-neg-hold

511 kohm sampling measurement with negative hold time

Subthreshold MOSFET subthreshold measurement

Trng C-f Direct Control (C-f measurement)

Trng Cgg-Vg Cgg-V g modification example for multi-frequency
Trng CV MOSFET C-V measurement

Trng Id-Vd

MOSFET |d-Vd measurement




Test Setup Name

Description

Trng List MOSFET Vth-gmmax measurement using I/V List Sweep
Trng Multi Multi Channel I/V Sweep (Bipolar transistor and LED)
Trng Sampling 0.1 uF sampling measurement

Trng Switch B2200/E5250 switch setup, Input 1-3-5-7 to Output 1-3-5-7

Vth gmMax and Id

Vth gmMax modification example to use auto analysis twice

Zero-check

SMU open measurement

Zero-check-ASU

SMU open measurement with ASU




Required Devicesfor Class Exercises

To perform the class exercises, you need the device set (Agilent part number 04156-87001)
which contains the following devices.

Description Quantity
N-channel MOSFET 2ea
NPN Bipolar Transistor lea
Red Miniature LED lea
0.1 uF Capacitor 50 V lea
1.0 Q Resistor 1/8 W lea
1.1 kQ Resistor /8 W lea
511 kQ Resistor 1/8 W lea

-

N-ch MOSFET NPN bipolar Transistor

Brown Brown

LED
Black Brown
Black Black
Silver Brown

1 ohm Resistor 1.1 kohm Resistor

Green

Brown
Brown
Orange

— S—

511 kohm Resistor 0.1 uF Capacitor



Required Accessoriesfor Class Exercises

To perform the class exercises, you need the following accessories. Prepare the accessories
shown below.

Designation Description M odel No. Qty.
1 Test Fixture 16442A/8 @ lea

28 pin socket module lea

Connection wire 6ea

2 Triaxial Cable 16494A 4 ea

3 Interlock Cable 16493J lea

4 Kelvin Triaxial Cable, for Module 5 16493K lea

5 CMU Cable, for Module 8 N1300A lea

6 Atto Sense/Switch Unit, for Module 6 E5288A lea
ASU control cable, triax cable, for Module 6 16493M lea

a. The 16058A Test Fixture for the 4145A/B may be substituted for the
16442A/B Test Fixture. If you use the 16058A, you also need the 16435A
Interlock Adapter.

28 pin DIP Socket Module (1ea.)

oco0o0o0o00
ocooo
0000
ocooo
cooo
000000

T F——1.

Connection Wire (6ea.)

E5288A ASU (lea.)
16442A/B Test Fixture (1lea.)

@)  ao——w ===}

Triaxial Cable (4ea.) Control Cable (lea.)
INTLK Cable (1ea.) Triaxial Cable (lea.)

<4 D=
N
@ |:| = |:|
L— A D

Kelvin Triaxial Cable (lea.)

i
@ E CMU Cable (1ea.)
[ N

L ]




To perform the flash memory class exercise in Module 13 and if you use the ASU, you
need the following accessories.

Description Model No. Qty.

ASU (Atto Sense/Switch Unit) with control cable E5288A Total
3sets

Triaxial Cable 16494A or Total
equivalent Tea.

BNC-SMA Cable 16493P 3ea
SMA-SMA Cable, for synchronization of SPGU 16493Q 2ea

To perform the flash memory class exercise in Module 13 and if you use the selector, you
need the following accessories.

Description Model No. Qty.
SMU/PG selector with control cable 2 16440A 2 sets
Selector adapter with control cable 16445A 1 set
Triaxial Cable 16494A or Total
equivalent Tea.
BNC-SMA Cable 16493P 3ea
SMA-SMA Cable, for synchronization of SPGU 16493Q 2ea

a. One selector can be replaced with one ASU.



Module 1. Introduction

* New Features

 EasyEXPERT

* To Perform Easy Application Test
* User Interface

* Modular Mainframe
 SCUU/GSWU

e ASU

* SMUJ/Pulse Generator Selector

» B2200/E5250 Switch Control

* Desktop EasyEXPERT

Module 2. Getting Started

e To Turn on/off B1500A

* To Launch EasyEXPERT

» To Specify/Create Workspace

* To Perform Application Test

» To Save/Recall Your Test Setup

» To Export/Import Your Preset Group
* To Export/Import Test Record

e To Perform Quick Test

* To Control Switching Matrix

* To Manage Data Display Window

Contents-1

Contents



Module 3. Data Display and Management

» Data Display window

* Graph Analysis Tools

» Data Status

» To Change Graph/List/Display Setup
* To See Print Preview

* To Print Display Data

* To Copy Graph Plot/List Data

» To Save Analysis Result

e To Use Preview Window

Module 4. Classic Test Environment

» Classic Test Execution Mode

* 1/V Sweep Measurement

e Multi Channel I/V Sweep Measurement
* I/V List Sweep Measurement

e I/V-t Sampling Measurement

* C-V Sweep Measurement

» Switching Matrix Control

* Direct Control

Contents-2
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Module 5. Basic Measurement

* SMU Fundamentals

* Classic Test Environment

* SMUs Connected in Series or Parallel
e Cabling and Fixture Issues

* Kelvin and Driven Guard

* Probes and Prober Connections

* Triax and Coax Adapters

» Safety Interlock Issues

Module 6. Low Current Measurement

* Low-Current Measurement Challenges

» Calibration and Zero Cancel

» Effect of Cable Movement

» ASU for Ultra Low-Current Measurement
* Low-Current Subthreshold

» Trade-Off Speed Vs Accuracy

* Low-Current Gummel Plot

* Low-Current Gate Oxide Leakage

Contents-3
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Module 7. Measurement Functions

* SMU Pulsed Sweep Measurement

* I/V-t Sampling Measurement

* Negative Hold Time for High Speed Sampling
e Auto Analysis

* SMU Filter

* SMU Series Resistor

» Standby Function

e Bias Hold Function

Module 8. Capacitance Measurement

* CMU Fundamentals

» Classic Test Environment

* CMU Calibration

* SCUU for IV/ICV Switching

* GSWU for Accurate Capacitance Measurement
* ASU for IV/CV Switching

Contents-4
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Module 9. Modifying Application Test Definitions

* To Open Application Test Definition

* To Modify Test Definition

* To Use Debug Tools

* To Use Built-in Functions

* To Add Data Display

* To Use Auto Analysis

e To Use Test Setup Internal Variables

* To Use Auto Analysis twice (as Class Exercise)

* To Use Vector Data (as Class Exercise)

Module 10. Creating Your Test Definitions

* What is Test Definition

* What is Test Contents

* To Open Test Definition Editor
» To Define Test Specification

* To Define Test Contents

* Available Elements

» Available Variables

» To Define Test Output

Contents-b
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Module 11. Advanced Definitions and Operations

» To Control External GPIB Devices
» To Call Execution Files

* To Perform Repeat Measurements
* Prober Control Script

Module 12. Miscellaneous Operations

* Function Status Indicator

* Run Option

* Automatic Data Export and Data Record
» Calibration

* Configuration

e XSLT Samples

* To Enable System Controller

» To Start Desktop EasyEXPERT

* To Use 415x Setup File Converter

Contents-6
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Module 13. SPGU Control and Applications

* High Voltage SPGU
SPGU Control

e Pulse Generator Mode

* Charge Pumping
* Flash Memory Test
* ALWG Mode

Contents-7
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10 Creating Your Test Definitions




Module 10
Creating Your Test Definitions

In This Module

* What is Test Definition

* What is Test Contents

e To Open Test Definition Editor
» To Define Test Specification

» To Define Test Contents

» Available Elements

» Available Variables

* To Define Test Output

This section explains how to create your test definition. You will perform the above tasks to create
the definition.

10-2



Module 10

Creating Your Test Definitions

What is Test Definition

Test Specification

*Test name *Multi display mode

Test description *Variables

*Variables *Analysis parameters
*Device parameters Test result display
Test parameters *X-Y graph

*Entry fields Data list

eParameter display

eLocal variables
Test execution flow
*Test setup
*Classic test
Test Contents eApplication test
*My Favorite setup

Test definition consists of test specification, test contents, and test output setup. The test
specification contains test name, description, device parameters, and test parameters. The parameters
will be the variables used to pass the test conditions to the test execution flow or test setup defined in
the test contents. Especially for the test parameters, you can specify the position of entry field for
each parameter. You can see the entry fields when the main screen displays this application test
setup. The test contents are the core of the test definition. You will define the local variables, test
execution flow, and test setup. You can define the test setup by selecting application tests, classic
tests, or my favorite setup, and entering the test conditions.

The test output setup is optional. If you have the following requirements, declare the analysis
parameters and define the display parameters on the Test Output tab screen.

-To send the test data to the subsequent tests

-To make the program branching depends on the test data

-To display/record the calculation result using the test data

-To display/record the test data of this application test

-To change the multi display mode of this application test

Note: You can use the device parameters, test parameters, and analysis parameters in the test
execution flow (program flow) of the test contents without declaration of local variables.

Note: If the multi display mode is Disabled, the all test result data will be displayed on the singular
Data Display window. If the multi display mode is Enabled, the test result data of the same test setup
name will be displayed on the exclusive Data Display window and the test result data of the different
test setup name will be displayed on the new Data Display window.

10-3



Module 10
Creating Your Test Definitions

What is Test Contents

Test Specification Test Output

Variables Variables

*Device parameters
*Test parameters

Local variables

Program Component

Application Test

*Analysis parameters

Miscellaneous

Test contents are the test execution flow (program flow), and is the core of the test definition. In the

test contents, the following elements can be defined.
eLocal variables

*Program components

*Application tests

+Classic tests

*My Favorite setup

*Analysis components

*Miscellaneous components

*Device parameters defined in the test specification
*Test parameters defined in the test specification
*Analysis parameters defined in the test output

The program is executed from top to bottom in the test execution program list.

10-4



Module 10
Creating Your Test Definitions

To Open Test Definition Editor

File Data Display Help

O
m
=
5
»

v Exercise L
[ GenericTest

[ Memory

[ MixedSignal =]

Library ~  Cancel
E] efinie Hew Test..,. Define New Test...
e

Trrg Idvd Delete Definitiomof This Test plication test object from the left area.
Yh

Import Test Definition, ..
&j“! Export Test Definition, .
=

Trng
Cgg-vg
_‘Li_l,_
Trng idvd
idvg2

bl

=1 Choose test categories from the left area.

| uick Test [ classic Test | Anplication T

To start test definition, open the test definition editor.

Select the Application Test tab, click the Library button, and select the Define New Test

... function.
The test definition editor will be opened. See next slide.
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Module 10

Creating Your Test Definitions

To Define Test Specification

) Untitled

~lojx|
Fle _Help
s s st |
Tiesd Information
Category: | [ Deseription: | Descriotion of thes test =
Test Name: [ ¥iiod = Set test information
feon: | Beprwse... l.‘bal ¥l
Duvice Par smetirs Doliition TProperties
[ T R
Name: Default: Description:
Set properties
To add & device paramater, prase the [Add] bution in this area.
of parameter
Define device parameters
Test Parameters Definition
Background: | Browia... (barl uur.u|| i | 5 r
MName:  Type:  Delaull: Description: Aligr: ¥ ¥ Width:  Ext:
To add a st parameter, press S [Add] button in this anea.

The test definition editor provides three tabs, Test Specification, Test Contents, and Test Output. At
first define the test specification. Click the Test Specification tab.

In the Test Information area:

«Click the right button in the Category field to specify the category the new test definition belongs.
Enter the Test Name.

«Select the Icon that will be displayed on the list area below the Library button of the main screen. It
is the image file used to select the test definition. See previous slide.

Enter the Description of the test.
In the Device Parameters Definition area:
«Click Add button to display the entry fields for the parameter.

Set the Name, Default value, and Description for the parameter. When you add a parameter, you
will see the entry fields at the Properties area. The area shows you the properties (minimum value,
maximum value, number of effective digits, resolution, and unit) for the device parameter or the test
parameter specified by the radio button put on the left of the parameter name.

For the Typical Values... button and the Symbols... button, see online help or User’s Guide.
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Module 10

Creating Your Test Definitions

To Define Test Specification

untitled : o=
Fle _Help
Test Spocication | Test Contents | Test Cutput |
[Teest Tnifarmation |
Category: | B Description: [Descreton of the tas ==
Test Name: [ nttiod =
feon: | Brpwse... | Clear I ]
Device Paramcters Definition [Propertics
U o |
Name: Default: Description:
Set properties
To add & devios paramater, prese the [Add] button in this anea.
of parameter
Test Parameters Definition
Background: | Browse... | Chaa | uur.u|| i | 5 '
MName:  Type:  Defaull: Description: Aligr: ¥ ¥ Width:  Ext:
To add a st parameter, press S [Add] button in this anea.
Define test parameters

In the Test Parameters Definition area:

«Select the Background that will be displayed on the application test setup area of the main screen.
Usually it is the image that shows the device connections.

Set the Name, data type, Default value, and Description for the parameter. When you add a
parameter, you will see the entry fields at the Properties area. The area shows you the properties
(minimum value, maximum value, number of effective digits, resolution, and unit) for the device
parameter or the test parameter specified by the radio button put on the left of the parameter name.

«Set the X, Y, and Width values to specify the position of entry field displayed on the application test
setup area.

*Check the Align box to set the X origin of entry field to the left edge of the entry field. Uncheck
this box to set it to the left edge of the parameter name placed left next to the entry field.

*Check the Ext box. The entry field will be put on the Extended Test Parameters dialog box that is
displayed by clicking the Extended Setup button on the application test setup area of the main screen.
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Module 10
Creating Your Test Definitions

[ Frmakivdiive =10l
Fie teb
mmﬂc.mm]mmm| Test utpus |
ocmath J
Sataary: F e e K gt -4
Tt Naames: [Tirea ichvd ibvg -
teon: [ PERT\ By | cpr | &
[Device Paramatars Dofinition [Proporties ]
Nam: Defaudt: Duscription:
c CE = =
(all =] = W e =
[Tt Barametars Dofinition ]
Backgrouna: [Fogram Fles| AplentB SO0 EanERPER Ty B | i | e | ; |
MName: Type: Default: Description: Align: ¥ L H] Width:  Ext:
r [ran | T =T lpaiter dan = FEo 5= §gF - =
[l ™) sk =fam =[5 for gate s Fhuo 6@ §5FE §C-
e foote  mpodie  s|EAian =][E0 Tor source = FE0 §pw Epo Er
o fts mwak  v[pwine S s I = T I
c fevE e =]lom v [ gate st voltage = F[io s EE s
r [ ety mlhamere S0 mv W[Fd gate ep vorage W Fwo @ E@Em &
Pl T | rop— =N B1ba eriar oF crans foe 170 U7 & chwm @ e sl =

This example sets:

Category: Exercise (This category may be created by the class exercise in Module 9)

Test Name: Trng idvd idvg
Icon: MOSFET.bmp
Device parameters:
Hold and Delay
Background: Vth_Const_1d.PNG
Test parameters:
Drain, Gate, Source, Subs, Idcomp, lgcomp

Idvd_V1start, Idvd_V1istep, IdvVd_V1stop, IdVd_V2start, IdVd_V2step, IdvVd_V2nop
Idvg_V1start, IdVg_V1stop, IdVg_V1istep, IdVg_Vdrain

Vsource, Vsubs

Entry field properties: 80 (width) x 30 (distance in vertical direction)

Press the Layout... button to open the Define Layout dialog box.
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Module 10

Creating Your Test Definitions

Setup example - Layout

Define Layout

File Edt “iew Align Distribute Centralize Tab Order

Idvg_Vistart: [-S00mv B Idvg_¥drain: |1I]EI '

£l

Idvg_Yistep: |10 mv B

Idvg_Vistop: 2000V B

0K | Cancel

Primary Entry Field

The Define Layout dialog box is used to define the layout of the test parameter entry fields displayed

on the application test setup screen.
The following methods are available for selecting the entry fields.

*Click on the entry field. Multiple entry fields can be selected by clicking on the entry field while
holding down the Ctrl key on the keyboard.

*Drag the mouse to draw a rectangle around multiple entry fields.
«Select Select All from the EDIT menu to select all entry fields.

The selected entry fields are outlined by the blue rectangles. The primary entry field, which is the
base for layout operations, is surrounded by a highlighted blue rectangle. Only one primary entry
field can be selected. To change the primary entry field, click on a selected entry field. The entry
field is always that was most recently clicked will be the primary entry field.

The following methods are available for releasing (unselecting) the selected entry fields.

«Click the selected entry field while holding down the Shift key on the keyboard.

*Click outside of the selected entry fields to release all selected entry fields.

The following methods are available for defining the layout of the selected entry fields.

*Drag & drop with the mouse to move the selected entry field(s).

*Change the X/Y values in the property window to move the selected entry field(s).

*Press the arrow keys on the keyboard to move the selected entry field(s).

*Use the functions in the Align menu to align the selected entry field(s) to the primary entry field.

*Use the functions in the Distribute menu to evenly distribute the selected entry fields horizontally or

vertically.

*Use the functions in the Centralize menu to move the horizontal or vertical center of all selected
entry fields to the horizontal or vertical center of the entry field area.

For more information, see online help or User’s Guide.
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Module 10
Creating Your Test Definitions

Result example

@ Trng idvd dvg

o fr 8]

.mgég §
I ].|i i

v _vzstars: ooy W)

 Quick Test | hassic vt | Fomiicanon Test
i
8

'ﬁﬁm 1vd_vastep: i W
ﬂﬁ wavl_vanop: i W
4;% Gates W = W : Drain: SR = ]
* igecenp: 0 W ddoomp: Ema [] .‘
"Eé“ Kvg Vistart: [S00mv W L‘} [ ]lmuy&ﬁ:nmw [] A
ﬂ 1vg_vistep: fionw 0 - = r—
Trrg it IV Vistop: Foo0v W) 1 J ‘
Lre g ceeE
ﬂ Source: ﬁ:mﬁ 3 Sulrs: 1+P ¥ ‘ P —
ol vsource: 77 ] v wsubs: {7 1} s
g L =l
Flag | Sehp hame | Diate |Count | Devica ID | Remarke E
Zerorthedh 11/13/2006 6:20:05PM 1 |
Trrg Sampling 12/11/2006 4:09:44 PM 1 |
Trrg lvd Vit 12/14/2006 7:30:43PM ' 1
Trrg Iavd ldvg 12/15/2006 7:33:00PM 1
Trrg lched ichg3 12/19/2006 2:52:44 PM | 1
Trmg I g2 AHIH006 2504 P 1 =
- "l vkingly ofF [ Sy o il T il

This is a result example of the test specification setup shown in the previous pages.
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To Define Test Contents

[ ucied =10/

Fe Hee
Test Soechcation Tost Contorts | Tast cutput|

B & ® 0 O ® M I © A

BLOCK  OMERROR FINALLY IF LOOR FOR ASSIGN  COMMENT

(3 ¢t [ oohcation Test | anavs | Gireac Tost | Mecolinoous | My Favorito Sotug |
3
Selaction =

5. _Clisr;k Insirt or

desired button . .
= - 2. Define the local variables used
BLOCK in this test contents

END BLOCK

BD FROR
4. Select available element

ETHEED

—

|r
»
n
.

3. Specify the line
to insert element No Parameter Settings
or to be edited

6. Define the setup required for
the highlighted line (element)

Starting to define the test contents:

1. Highlight the Local Variables Definition line.

2. Define the local variables used in this test contents (test execution flow).
3. Highlight the line that an element has to be inserted.

4. Highlight an element of Program Component, Application Test, Analysis, Classic Test,
Miscellaneous, or My Favorite Setup tab menu.

5. Click the Insert button of the Edit tab menu. The element will be inserted between the highlighted
line and the next line.

6. Define the required setup.

To edit the test contents:

1. Optional. Highlight the Local Variables Definition line.

2. Optional. Define the local variables used in this test contents (test execution flow).
3. Highlight the line to be edited.

4. Highlight an additional element if you need.

5. Click the desired button if you need.

6. Define the required setup if you need.

Repeat this to create the test contents (test execution flow).
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Available elements

FhARan 0B M- A

- =N R R

Program Component

Application Test

Analysis

Classic Test

Miscellaneous

My Favorite

Available elements are shown above. The Program Component provides the typical program
statements such as IF, LOOP, FOR, and so on. They are used to control the test execution flow. The
Application Test, Classic Test, and My Favorite are used to define the test setup/test condition. The
Analysis provides the elements used to control auto analysis function and data display. And the
Miscellaneous provides other useful elements. For details of elements, see online help or user’s

guide.
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Avalilable variables

Test Contents
eL_ocal variables

Test Specification
*Device parameters
*Test parameters

Test Output
*Analysis parameters

Do not set the same name
for variables and
parameters. The name
must be unique.

| Assign to external variables... |

2 |

External varisbe: Measurement data:

| Extornal Vartable Setuss
Variabie sus——rty

Gone

You can connect the
variables in test setup with
L ocal variables

*Device parameters

*Test parameters
*Analysis parameters

In the test execution flow (program flow), you can use the following variables.
*Variables defined by the Local Variables Definition component

*Device parameters defined in the Test Specification

Test parameters defined in the Test Specification

*Analysis parameters defined in the Test Output

You may want to read the parameters/variables used in Classic Test setup or Application Test setup
defined in the Test Contents. Then use the External Variables Setup dialog box or built-in functions.
They can connect the test setup internal variables/parameters to the external variables listed above.
For the example variable connections, see “To Use Test Setup Internal Variables” in Module 9.

Note: Application test internal parameter/variable to be connected to an external variable must be the

analysis parameter in its test definition.
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Creating Your Test Definitions

Defining local variables

Local Variables Definition

N~ 5]
[Fle Help

Tast Soacheate

L=
BLOC

variabls

¢ Assign Uineas Values FROM [0 5 w | 5

Assign Linear Valves FROM | & sTER

Strinng Variable |

Mame: [T50 - Valoe: [ = Description: | -

Modue Variable |

Mame: 3500 ) Descrigtion: | -

Add Numeric Variable button displays the Numeric Variable area that provides the following fields.

*Name: Numeric variable name

*Value: Initial value of the variable

Description: Additional information for the variable

Add Vector Variable button displays the Vector Variable area that provides the following fields.
*Name: Vector variable name. Two dimensional array.

*Count: Number of elements, or array size

*Description: Additional information for the variable

This area also provides the following radio button used to specify how to set the initial value of the
array data automatically.

* Assign Linear Values FROM [value of first element] TO [value of last element]

If Count>1, this sets first value + (N-1) x (last value-first value)/(Count-1) to the N-th element. If
Count=1, this sets first value(=last value) to the element.

* Assign Linear Values FROM [value of first element] STEP [step value]

This sets first value + (N-1) x step to the N-th element.

Add String Variable button displays the String Variable area that provides the following fields.
*Name: String variable name

*Value: Initial value of the variable

*Description: Additional information for the variable

Add Module Variable button displays the Module Variable area that provides the following fields.
*Name: Module variable name

«Description: Additional information for the variable
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Editing test contents

= ' e
File Help

: h o0 e HOe A

(1] ERFOR

Tast Soachearon

= h

e O

2

nnnnn

«Block Selection

eInsert
*Delete
«Copy
Cut
*Paste

Mo Parameter Settings.

The Edit tab provides the following buttons:

*Block Selection/Line Selection toggle button selects the edit target selection mode. In the line
selection mode, clicking line just selects the line. In the block selection mode, clicking line selects
the block the line belongs.

eInsert button inserts the specified element between the highlighted line and the next line.
Delete button deletes the highlighted line.

«Copy button copies the highlighted line to the clipboard.

Cut button moves the highlighted line to the clipboard.

ePaste button inserts the line in the clipboard between the highlighted line and the next line.
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Debug menu

| Untitied ' M1
Fle Help
Tas Test Tes Outnut

*Run

*Abort e
*Stop

*Break

*Inspect

The Debug tab menu provides the following buttons:

*Run button starts the debug (executes the test flow). During execution, the label changes to Pause.
Clicking Pause button pauses the execution, and changes the label to Run that is used to continue the
debug (execution).

*Abort button aborts the debug (execution).

«Step button executes the highlighted line of the test flow. Clicking the button repeatedly continues
the execution by a line.

Break button sets/releases the break point. For the break point, this button releases the break point
from the highlighted line. Program execution will break at the break point automatically.

eInspect button is available when the debug (execution) is paused or broken. This button opens the
Variable Inspector used to monitor value of device parameters, test parameters, analysis parameters,
local variables, or system variables.
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Creating Your Test Definitions

Class Exercise

Create test definition and perform test.
1. Open test definition editor.

2. Define Test Specification (see previous page)
3. Define Test Contents shown below.

4,
5
6

Save the definition as Trng idvd idvg.

. Use debug tools to check the definition. SMU4

. Connect device, and perform test. SMOBT -
SMU1

SMU2

Test Contents:

Local Variables Definition

BLOCK
IDVD

Message
IF Yes=0

END
END IF

GMMAX
END BLOCK
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Test Definition Example

@ Tong ioivd by -JOE

File Help
Tast Spechiaton  Tess Contents | Test mm:l

oo | B O M M 8 4 4 4 4 4 °
Dama ol -vd o wR Farallal REKELY  Faralielfom Zero-check Zero-che.. G Bt
- - - - - . . . - - 3
Program Campanent | Apphcaton Test | Anabss | Classe Test | Mscelaneous &fmm Satup
& @D| 1/V Sweep Setup Mane: E\'n =
o et " Dlete || Channel Seup Wessurement S0 | Funcoon Setun | Auta Anakes Setwa | Doy Seca |
T VAR2
£ Rangs
& Uniit: snu:- [} 510 5
Copy cut Mame: V6 =W Apci
i Srgie v b
Local Variables Defini = ,—;| Ad
BLOCE Liasri Lope | RAR vanced
Ve start: fl2vd_Viset lave_vasart —
Meszage |
IF Yes=0
END
END IF
GMMAX
END BLOCK

1 Marnme: Mo

Uit ¥ Manwe:
[Fauksies ) ] fien =V
4 lw = =

Use IDVD and GMMAX in the Demo preset group (My Favorite Setup) for the test setup.

Use the variables defined in the Test Specification to set the Unit on the Channel Setup, the source
values on the Measurement Setup, the Min and Max values on the Display Setup, and so on.

For the example definition, open the Trng idvd idvg definition stored in the \data folder on the

Manual CD-ROM. The Manual CD-ROM stores the example test setup and definition data used in
this manual.
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Measurement Result Example

=

Cursor  Line  Window

HAQRA-DEHEEe - E60 [ |

vy QAT DS PEAK
500 MV 54365076099,  §74.303219603...

MY 22073972141, PRLRETAA04E..,
480 254050675676...  -70.245002%05...

This is a test result example displayed on the Data Display window.

10-19



Module 10

Creating Your Test Definitions

To Define Test Output

=101 x}
e 2. Define the analysis parameters
F pefine Outps [ Dafine Anahis Paametsrs. . ]
Allocate Data pisplay for oach test: [rchy vih &ove vl -] ——————— 6, Select the multi display mode
[T Comply with above|level
7 N T = Enable
Name: Sharlng:  Scale: Min: Ma: 4
o | 3 e d e 2P i 0 Bifable
To add & Y- parametor, prigs e [Add] button in e area
3. Specify X axis and Y axis
(it Displary Paramitirs

To add & parameter, press the [Add) To add a parameter, press the [Add]

button in this area. button n his area.
4. Select variables to list 5. Select parameters
to display

The test output setup is optional. If you have the following requirements, define the analysis
parameters and set the display parameters.

-To send the test result data to the subsequent tests in an application test

-To make the program branching depends on the test result

-To make the calculation using the test data in the Test Contents

-To display/record the test result of this application test

-To change the multi display mode of this application test

To define the test output:
1. Check the Define own Output Parameters box.

2. Click the Define Analysis Parameters... button. And define the analysis parameters on the
Analysis Parameter Definition window.

3. Specify X axis and Y axis of the X-Y Graph of the Data Display window.

4. Select variables to list in the List Display area of the Data Display window.

5. Select variables to display in the Parameters area of the Data Display window.

6. Select the multi display mode using the Allocate Data Display for each test pull-down menu.

Note: If the multi display mode is Disabled, the all test result data will be displayed on the singular
Data Display window. If the multi display mode is Enabled, the test result data of the same test setup
name will be displayed on the exclusive Data Display window and the test result data of the different
test setup name will be displayed on the new Data Display window.
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To Define Test Output
Analysis Parameters

| Define Analysis Parameters...

| natysis Parameter Detinition

Vector Parameters
up
Mame: Ui
e [ = |
c [io B L |
e o =: -
& [om_max B =
Scalar Parambers
Add Delete | |
Mamee: Uit Geaiim
[T v ¥|[Threshald vorape -
Oase

Define the analysis parameters as shown below:

At the Vector Parameters area or the Scalar Parameters area:

1. Click the Add button.

2. Enter the Name, Unit, and Description of the parameter.
For the sweep output/measurement data, use the vector parameter.

For the spot output/measurement data, use the scalar parameter.

For the data given by the max( ) and min(') built-in function, use the vector parameter.

In this example, VG, ID, and GM are the vector parameter and VTH is the scalar parameter.
GM_MAX is the vector parameter because the max( ) built-in function is used to calculate this value.
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Creating Your Test Definitions

To Define Test Output
Display Parameters

| Trng idva Vivg cog
Fie Help
Test Spechcanon | Tast Contents Tt Outaut
¥ Defien own Qutpat Parameters Define Anabris Pacarmetpts

(K% Giraph

P ox

L

coyxn fom =] [imes =] s § [i5=s O]

[t wispiay ] [P
B3| | I | gy

This example sets:

X-Y Graph: ID-VG plot for Y1-X graph and GM-VG plot for Y2-X graph
List Display: VG, ID, and GM

Parameters: GM_MAX and VTH

All parameters must be defined in the Analysis Parameter Definition window shown in the previous
slide.

The X-Y Graph area is used to set the X axis and Y axis of the X-Y Graph Plot area on the Data
Display window.

*Name: Name of variable to plot on the X axis

Scale: Linear or Log

*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed on the List Display area of the Data Display
window. Up to 20 variables can be set.

The Parameters area selects the variables to be listed on the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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Module 11
Advanced Definitions and Operations

In This Module

e To Control External GPIB Devices
e To Call Execution Files
e To Perform Repeat Measurements

* Prober Control Script
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To Control External GPIB Devices

Miscellaneous: GPIB 1/0

Write String  to send a string command to GPIB device
Write Value  to send a command to GPIB device
Read String  to read a string value from GPIB device
Read Value  to read a numeric value data from GPIB device
Read List to read a vector data from GPIB device
Read STB to read status byte of GPIB device
GP-1B Control Group Execution Trigger

Device Clear

Go To Local

Local LockOut

You can control external GPIB devices from the EasyEXPERT by using the GPIB 1/O statement.
The GPIB 1/O statement provides the write/read functions shown above. Select a write function and
enter the necessary parameters to send a command to the GPIB device. Select a read function and
enter the necessary parameters to read response from the GPIB device. For details, see online help or
User’s Guide.

The followings are the GPIB Control functions.

*Group Execution Trigger: Sends a trigger to the specified GPIB device.
Device Clear: Sends a device clear to the specified GPIB device.

*Go To Local: Returns the specified GPIB device to the local state.
Local LockOut: Locks the specified GPIB device.

Note: Before starting, enable System Controller. See Module 12. Also establish the GPIB
connection with the external GPIB devices.
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To Control External GPIB Devices

Agilent B2200 control example

To send command @wem Toe

File Help
Tast Spechianon  Test Contents | Tae Outsus

Programming image:

*RST

:ROUT:FUNC ACON

(enters “SMUL1” to StringPort)
:ROUT:SYMB:PORT {0},"{1}"
:ROUT:SYMB:PORT? {0}
(reads string data)

*OPC?

(reads operation complete flag)
(enters “OUT1" to StringCh)
[:ROUT:SYMB:CHAN {0},{2},"{1}
:ROUT:SYMB:CHAN? {0},{2}

Terminator: [LFE01 =

valsn 4 |

Valuel — {0}
Value2 — {1}

£§g((j:s’)strlng data) Value 3 2
(reads operation complete flag) |« | N Value4 — {3}

This slide shows an example setup of the GPIB 1/O statement. This is a component of the test
contents used to control the Agilent B2200 switching matrix.

This example uses the Write Value function to send the following command to the B2200.
:ROUT:SYMB:CHAN {0},{2},"{1}"

where, {0} is CardNo, {1} is StringCh, and {2} is ChanNo.

The followings are the reference of the setup editor.

*Address: GPIB address of the device

*Terminator: EOI, LF, CR/LF, LF+EOI, CR/LF+EOI, or NONE (no terminator)
eFormat: Command (header and parameters) sent to the device

*Value 1: Value for {0}

*Value 2: Value for {1}

*Value 3: Value for {2}

*Value 4: Value for {3}

{0}. {1}, {2}, and {3} are variable available in the Format field only.

Note: Use double quotes to enter a string to a local variable by using the Assign statement.
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To Control External GPIB Devices

Agilent B2200 control example

To read data [ _ 5 %)
| Ale- Help |
| Temsoechazon Test contems | Tas ousie | |

Bl @ =
GFE V0| Messoge Command Dt Seore
Execution L ]

Programming image: [Function

‘Write String © Write Value
*RST m} ~ Rasd Vakie ~ Read Lt ~ Read STR
:ROUT:FUNC ACON O Lo )
(enters “SMU1" to StringPort) Togi e N e e
:ROUT:SYMB:PORT {0},"{1}" =
:ROUT:SYMB:PORT? {0} Mivess: [ ] Tineout: [1803 5
(reads string data) string:
*OPC? Length To Read: |1 W Longih Actually Read: (L7 1 =l
(reads operation complete flag) Toeminator:  [FE0T 5] Terminatod: 3]
(enters “OUT1" to StringCh) »
:ROUT:SYMB:CHAN {0},{2},"{1}"
:ROUT:SYMB:CHAN? {0},{2}
((reads string data) ]
*OPC? |

=

(reads operation complete flag) |

This example uses the Read String function to read the response from the B2200. This example
reads the :ROUT:SYMB:CHAN? query command response. The result (ReturnCh value) must be
OUTL.
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To Call Execution Files

Miscellaneous: Command Execution

@it M1

Fle Help

Tast Spechicamon  Test Contents | Tem Outsut

#|

-1 Specifies vector variable or
string sent to the exe file. = )

]
~

Result:  [Faus - Value:  [Fetovaie -l
Specifies variables used to receive execution

results or output data. This area is deleted
by Read Type: None.

J

You can call the execution file (EXE file) from the EasyEXPERT. Use the Command Execution
statement and define the setup editor as shown in this example.

*Command Filename: Execution file name (command name)

*Argument: Command parameter or argument

*Write Type: String or List (vector data)

*Read Type: String, Value (numeric data), List (vector data), or None (no read data)
If you specify Write String, enter the string sent to the command.

If you specify Write List, enter the name of vector variable sent to the command, and specify the
format of data element sent to the command. See next slide.

In the Read String/Value/List area, specify the variables used to receive execution result and output
data. There is no entry field for Read Type: None.

*Result: Numeric variable name. Used to store the execution result.

*Value: Numeric variable name for Read Value, or vector variable name for Read List. Used to
store the returned data.

«String: String variable name. Used to store the returned data.
sLength Actually Read: Numeric variable name. Used to store the byte length of the returned data.

The above example calls the sleep.exe file used to insert the wait time for program execution. The
WAIT value must be defined in msec. After the normal command execution, the sleep.exe returns 1
for Value and 0 for Result. The sleep.exe file is stored in the following folder.

C:\Program Files\Agilent\B1500A\EasyEXPERT\Utilities
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To set Format field

ULAIL-F1}

o List data index. Or index of element. Integer.

* [LA] Character length of the specified data element.
Positive integer for right-aligned, or negative
integer for left-aligned. Optional.

e [:F] Format identifier. C,D,E, F, G, N, P, R, or X.
Lower case is available. Optional.

Example:

{0,5:E} First element, 5 characters, exponential notation.
{1:G} Second element, general.

{2,10} Third element, 10 characters, general.

The Format field is used to specify the data format of List (vector variable). The strings shown in the
above example can be defined in the Format field.

In the strings, the list data index is mandatory. The character length and format identifier are
omissible. Then the length is not limited, and the format G is set.

C or c: Circulation

D or d: Decimal numeral

E or e: Exponential notation

F or f: Fixed point

G or g: General

N or n: Numeric

P or p: Percent

R or r: Round trip

X or x: Hexadecimal numeral

For the format, see online help or manual of the Agilent T&M Programmers ToolKkit.
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Exercise
Try to improve your test definition as you want.

» To Use Built-in Functions
» To Use Read Out Functions
» To Control External GPIB Devices

» To Call Execution Files
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To Perform Repeat Measurements e

- . Start (Run)
Repeat Measurement Setup Count=0

Repeat Procedures
Start Procedure:

JC:\Program Files\Agilent\B1500\EasyEXPERT ﬁ Browse...
Arguments: =

| | Start Procedure | |

Iteration Procedure:
|C:\Program Files\Agilent\B1500\EasyEXPERT glj Browse...

Arguments: _‘-@J
Final Procedure: TestE i
— es xecution
C:\Program Files\Agilent\B1500\EasyEXPERT & Browse... | |
| = .
Arguments: | =

Count=Count+1 |
¥ Automatically fill in Device ID T

Repeat Stop Condition \ o | | Iteration Procedure | |

Stop repeating by:

[—] No
[17 Counter reaching to: 5 B ] Abort |
[17 Procedure return condition ] Lcel‘ YeS Temem—rno |

| | Final Procedure | |
T

If Abort is clicked |

status limit End

Repeat measurement is performed as shown in this flowchart. The status is a response returned by
the start/iteration procedure. The Count is the accumulated number of test executions. They are the
stop condition of the repeat measurement.

The repeat measurement stop function is enabled by the following check boxes.
*Counter reaching to
*Procedure return condition

If the first box is checked and the limit value is specified, the repeat measurement will be stopped if
Count >= limit. To perform the repeat measurement, set the limit value more than the number of
devices under test or remove check from this box.

If the second box is checked, the repeat measurement will be stopped if status = True.

When the second box is checked, the device 1D automatic setup function is available and is
enabled/disabled by using the following check box. The function enters the device_id value to the
Device ID of the test result record. The device_id is a response returned by the start/iteration/subsite
procedure.

«Automatically fill in Device ID

The Repeat Measurement Setup dialog box provides the following action buttons.
*Run: Starts repeat measurement.

*Abort: Stops repeat measurement immediately.

*Cancel: Closes the Repeat Measurement Setup dialog box.

Start/Iteration/Final Procedure:
Enter the full path name of the procedure. For example, enter as follows.
C:\Program Files\Agilent\B1500\EasyE XPERT\UTtilities\ProberControl\suss\Start_suss.exe

Arguments:

Enter the options of the procedure. See the following pages describing about procedures. For
example, enter —a GPIBO::5::INSTR I C:\temp\prb.log.

If you use the sub die move operation (subsite procedure), the flowchart must be changed. See page
11-18.
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Subsite move Test Setup

File  Data Display  Help

| quicke Test: | sz Test | Appiaton Test

mgm - Specify ProberType. = B i
Or specify driver for your prober in d "
E CustomProber. 2
Treg gm St
= g SM-open
g Il
Subsite -
mine w ] HOUT-1-7
| | Flag | Setup Name | Date | Count | Device 1D | Remarks
0 IN-OUT-1-7 3/7/2006 6:43:40 PM 1
Tdvgvd 3712006 4:49:37 PM 2
— SWM-open 3/7/2006 4:45:40 PM 1
! 1d-vd 72006 4:45:45 PM 1
idvgvd 37/2006 4:45:33PM 1
(18] SWM-1tod 712006 4:45:26 PM 1 -

MU Zem 0FF [T e B 0N | Pute Racend O

If you do not use the sub die (subsite) move operation, skip this page.

Click Application Test tab and open the Subsite move test setup in the Utility category. On the
Subsite move setup screen, specify ProberType (Cascade, Suss, or Vector) or driver for your prober
in CustomerProber, and save it as a setup in your preset group (My Favorite Setup). Then you can
use the setup for your quick test. See next page.

The Subsite move setup moves wafer chuck to the next subsite, reads device ID from the prober, and
sets it to the Device ID of the test result record.

For more details of the test setup, open the Test Definition window.

In the Subsite move test definition, an execution file callProbeDvr.exe is used. This file is used to
send Subsite_xxxx.exe to the prober specified by the prober_info.ini file and receive the response;
status and device_id. The callProberDvr.exe has the following input/output parameters.

Input: Full path of Subsite_xxxx.exe
Output: status; True (error) or False (no error)
Output: device_id

Note: The callProberDvr.exe refers to the prober_info.ini file for the GPIB address and log file
name. Do not set the Arguments of Subsite_xxxx.exe.
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To Use Subsite move

File  Data Display  Help

B [may Favorite - |
iﬂmulcmmm 5 | i
| Selup Name =

-3
3
g 7% swM-1to7 v
£ |dl idvg - Quick Test List:
i @ S
lect al
Elmova , _ st |
P SWM-open g
"_é 1 IN-OUT-1-7 Repeat Measurement Setup
g Repeat Procedures
- ~Start Procedure: —
[C:\Program Files\Agilent\B1500\EasyEXP & | Browse... |
Arguments: | = Wavd
—Iteration Pr
Subsie
[C:\Program Files\Agilent\B1500\EasyEXP &  Browse... move
Argument:.:i E
~Final Procedure: o]
[C:\Program Files\Agilent\B1500\EasyEXP &  Browse...
- SWN-
Arguments.l il
VA ically fill in Device ID
| Flag | Setup Mame 5 2 our.
IN-QUT-1-7 Epeat Sty i | v
SWM-open [ Stop rep g by:
1d-vd ¥ Counter reaching to: 5 B Abort
hvgvd i
SWM-1to? ¥ Procedure return condition I |
ancel =T

If you do not use the sub die (subsite) move operation, skip this page.

To perform the test with the sub die move operation, do as follows.

Add the Subsite move test setup to your preset group (My Favorite setup).
Set your preset group and test setups in the Quick Test tab screen.

Open the Repeat Measurement Setup dialog box.

Specify the procedures and the repeat measurement condition.

A A

Start repeat measurement.
The Subsite move setup must be entered after measurements for a sub die.
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Prober Control Script
* Prober information file  Use prober control script in EasyEXPERT
prober_info.ini  Repeat Measurement Setup window

Start Procedure
Start_xxxx.exe

Iteration Procedure
Iterator_xxxx.exe

Final Procedure
Final_xxxx.exe

Subsite Procedure

Subsite_xxxx.exe

XXXX: ® cascade

® SUSS

* vector

Prober control script is sample program used for semi-automatic prober control. The Agilent
EasyEXPERT can call the script by using the Repeat Measurement Setup window.

See page 11-9 to call the script and perform repeat measurement.
See page 11-14 for the prober information file.

See page 11-13 for the start procedure.

See page 11-15 for the iteration procedure.

See page 11-16 for the final procedure.

See page 11-17 for the subsite procedure.

To use the prober control script, specify the start/iteration/final procedure in the Repeat Measurement
Setup dialog box (see page 11-9). And use the Subsite move test setup in your quick test to control
sub die move. The Subsite move setup uses the subsite procedure for moving wafer chuck to the
next subsite. See page 11-10 and 11-11.
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Start_xxxx.exe
» Arguments: -a GPIB_address

-1 log_file_name | Displays Device ID Entry dialog box |
. - I
Example- | Updates prober_info.ini file |
—a GPIBO0::5::INSTR -l C:\temp\prb.log | |

I
* Response: XML format data

Displays Start Conﬁrmation dialog box

[ Moves to the first position |

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response> Gets X-Y coordinate
status: True (error) or False @ ‘
. . . . Prober error?
device _id: prefix:coordinate
Example: | Chuclk up
<Response> | Returns response |
<Break>False</Break>
<Target>wafla:3 1</Target>
</Response>

To specify the start procedure in the Repeat Measurement Setup dialog box, enter the full path name
of Start_xxxx.exe into the Start Procedure field.

After the repeat measurement is started, this procedure displays the Device ID Entry dialog box and
waits for your input. On the dialog box, enter a string used for the prefix of device_id. After that,
you will see the Start Confirmation dialog box that is used to confirm your wafer setup status. Load
wafer and perform wafer alignment, then click OK on the dialog box. The procedure moves wafer
chuck to the first probing position, checks the prober status, gets the X-Y coordinate of the probing
position, and sets the wafer chuck to the UP position. At last, the procedure returns the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When
the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the
repeat measurement will be stopped if status = True.

The device_id is a string for the Device ID of the test result record. When the Automatically fill in
Device ID box is checked in the Repeat Measurement Setup dialog box, the device_id will be entered
to the Device ID of the test result record.

If you use the subsite procedure, the flowchart must be changed. See page 11-18.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Prober_info.ini

[Prober]
Address=GPIB::5:INSTR —— GPIB address of prober
LogMode=True

LogName=C:\temp\prb.log | — Full path name of log file

[Target]
UselD=True » device_id = prefix:coordinate
Subsitelnfo=False |

WaferInfo=False <Response> £
ID ‘ <Break>False</Break>

i <Target/Target>

</Response>

ou enter in the Device ID Entry dialog box.
ID is automatically recorded in the prober_info.ini file.
The Device ID Entry dialog box is opened by Start_xxxx.exe.

The prober information file is necessary to execute the prober control script. Before starting tests,
open this file, edit it as you want, and overwrite it. The name must be prober_info.ini.

The prober_info.ini file stores the information shown below.
*Address: GPIB address of prober

eLogMode: Log file creation mode; True or False

eLogName: Log file name (full path)

*UselD: Device ID creation mode; True or False

Subsitelnfo: Set always False. This is just a place holder.
*WaferInfo: Set always False. This is just a place holder.

*ID: Ignore this variable. This is just a pass parameter.

If the procedures specify the —a option, the Address value is not used.
If the procedures specify the —I option, the LogName value is not used.
To create a log file, set LogMode=True.

To use the prefix:coordinate format for the device_id value, set UselD=True. If UselD=False, the
device_id value will be coordinate, not prefix:coordinate. The prefix will be the value entered in the
Device ID Entry dialog box that is opened by Start_xxxx.exe. This function is available when the
Automatically fill in Device ID check box is checked.
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Iterator xxxx.exe
- -Start
e Arguments: -a GPIB_address _

. Chuck d
-l log_file_name | dck comm |

—a GPIBO0::5::INSTR —I C:\temp\prb.log
No

* Response: XML format data [ Moves to the next position |

<Response> Prober error?
<Break>status</Break>
<Target>device_id</Target>

</Response> @ Gets X-Y coordinate

Example:

status: True (error) or False Prober error? Yes
device _id: prefix:coordinate
| Chuck up

Example: |
<Resp0n56> | Returns response |

<Break>False</Break>

<Target>wafla:4 1</Target> C End )
</Response>

To specify the iteration procedure in the Repeat Measurement Setup dialog box, enter the full path
name of Iterator_xxxx.exe into the Iteration Procedure field.

The procedure is called after the measurement is completed for a die. This procedure sets wafer
chuck to the DOWN position, moves it to the next probing position, checks the prober status, gets the
X-Y coordinate of the probing position, and sets the wafer chuck to the UP position. At last, the
procedure returns the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When
the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the
repeat measurement will be stopped if status = True.

The device_id is a string for the Device ID of the test result record. When the Automatically fill in
Device ID box is checked in the Repeat Measurement Setup dialog box, the device_id will be entered
to the Device ID of the test result record.

If you use the subsite procedure, the flowchart must be changed. See page 11-18.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Final _xxxx.exe
e Arguments: -a GPIB_address

-1 log_file_name
Example:
—a GPIBO0::5::INSTR -l C:\temp\prb.log
L4 Response none rRepeat Measurement Setup

Repeat Procedures
Start Procedure:

JC:\Program Files\Agilent\B1500\EasyEXP E Browse...
Argument-;:] ﬂ
( Start )
Tteration Procedure:
|C:\Program Files\Agilent\B1500\EasyEXP EJ Browse...

Argumenu:l EJ
| Chuck down |
Final Procedure:
\C:\Program Files\Agilent\B1500\EasyEXP Elj Browse...
Arguments:‘ Ej
End ¥ Automatically fill in Device ID

Repeat Stop Condition |
Run

Stop repeating by:

Sto p Cond iti on ¥ Counter reaching to: IS—E

¥ Procedure return condition
Cancel
-

To specify the final procedure on the Repeat Measurement Setup dialog box, enter the full path name
of Final_xxxx.exe into the Final Procedure field.

The procedure is called after one of the stop condition is detected. This procedure sets wafer chuck
to the DOWN position.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Subsite_xxxx.exe
— —-St t
e Arguments: -a GPIB_address -

- log_file_name | Chuck down |
Example:
—a GPIBO0::5::INSTR —I C:\temp\prb.log
N
« Response: XML format data °

[ Moves to the next subsite |

<Response> — - Yes
<Break>status</Break> rober error:

<Target>device_id</Target> No_
</Response> | Gets X-Y coordinate |
status: True (error) or False
device _id: prefix:coordinate

Chuck
Example: | uc| - |
|

<Response> | Returns response |

<Break>False</Break>

<Target>wafla:3 1</Target> End
</Response>

To realize sub die move operation, you need to define Subsite_xxxx.exe in your test definition and
create your application test setup. However, you do not need to take care of this procedure by using
the Subsite move test setup included in the application library. The Subsite move setup moves wafer
chuck to the next subsite, reads device ID from the prober, and sets it to the Device ID of the test
result record.

Open the Subsite move test setup and save it as a setup in your preset group (My Favorite Setup).
Then you can use the setup for your quick test.

Note: To use the Subsite move setup, set the GPIB address and log file name in the prober_info.ini.
And ignore the Arguments for Subsite_xxxx.exe.

Note: If you use a Suss prober, the number of Subsite move setups used in your quick test (die test)
is important. It must be N-1; N is the number of subsites defined in the prober.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When
the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the
repeat measurement will be stopped if status = True.

The device_id is a string for the Device ID of the test result record.
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To Change Execution Flow

[ TestExecution |

| |Subsite Plrocedure| |

Yes|

]
[ [Move to the 1% subsite |
[

If you use the subsite procedure, change the flowchart as follows.
On the page 11-9, replace the box A with the block A shown above.
On the page 11-13 and 11-15, insert the box B shown above to the position B of the flowchart.
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Miscellaneous Operations

In This Module

* Function Status Indicators

* Run Option

* Automatic Data Export and Data Record
» Calibration

» Configuration

* XSLT Filters

e To Enable System Controller

» To Start Desktop EasyEXPERT

» To Use 415x Setup File Converter

This module describes the above topics. You will understand what is the function status indicator,
how to change the function status, how to perform selftest and calibration, how to perform SMU zero
offset cancel, and so on.
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Function Status Indicators

Date | Count | Device 1D | Remarks

5/10/2007 &:42:51 FM 1
4/23/2007 509:36PM &
4/23/2007 9:12:45 AM 1
12/19/2006 2:52:44 PM 1
12/19/2006 2:52:04 PM 1
12/15/2006 7:358:01 FM 1

=l

|- Multi Display OFF ||| Standby oFF  J§10] SMU Zera OFF Lg fiuto Export OFF | 5| AutoRecord OM |

5! fute Expart o

#0] SMU Zero ON

[ Standoy ON_ |

Standby function OFF m ON

B4 Multi Display ON

Multiple data display OFF = ON

v

EE] Auto Record OFF

Automatic data record ON my OFF

Automatic data export OFF = ON

SMU zero offset cancel OFF my ON

Function status indicators let you know the status OFF or ON of the following functions. The

indicators are placed at the bottom of the main screen.

Multi Display OFF/ON: Shows the multiple data display function OFF or ON status.
Standby OFF/ON: Shows the standby function OFF or ON status.

SMU Zero OFF/ON: Shows the SMU zero offset cancel function OFF or ON status.
Auto Export OFF/ON: Shows the automatic data export function OFF or ON status.

Auto Record ON/OFF: Shows the automatic data record function ON or OFF status.

Clicking indicator controls the function ON/OFF directly or opens the dialog box or window which

controls the function status.

12-3

Module 12

Miscellaneous Operations



Module 12

Miscellaneous Operations

Run Option

Auto Export and Auto Record status:

=

[Slautobxport oFF | [ AwoRecordon g Save Data button
[Elavobgorton | [ElavoRecodon | o ! appears if the last
= . Device ID:
[Blauoexporton  [B¥] Auto Record OFF test result data is in
Run Option / My Favarite Setup- the memory when
. ScUINE | both Auto Export and
d | It =
v Record Test Result Data Automatically » {E‘Iri AutO RECO I’d are OFF,
¥ Allocate Data Display for each test cy-1MHz
i and allows you to save
Close g = | the last data as the
test result record.

Multi data display ON & mutt pisplayon

I Auto Export OFF and Auto Record OFF
™ Record Test Result Data Autornatically [ST futo Expart oFF ] Auto Recard oFF
I_I Allocate Data Display for each test

Multi data display OFF

Run Option button opens the Run Option dialog box used to change the status of the automatic data
record function, the automatic data export function, and the multiple data display function.

If the Record Test Result Data Automatically check box is checked, both or one of the automatic data
record function and the automatic data export function will be set to ON. To specify the function
status, see the next page.

If the Record Test Result Data Automatically check box is not checked, both functions are set to
OFF. In this status, both data record and data export are not performed. So the test execution time
will be reduced. Also, EasyEXPERT memorizes the last test result data. And it can be saved as a
test result record by clicking the Save Data button right next to the Run Option button. This status
will be useful for probe contact check, defect analysis, and so on.

The multiple data display function ON or OFF can be controlled by clicking the Multi Display
indicator or by using the Allocate Data Display for each test check box on the Run Option dialog
box.

About the multiple data display function:

If this function is OFF, the all test result data will be displayed on the singular Data Display window.
If this function is ON, the test result data of the same test setup name will be displayed on the
exclusive Data Display window and the test result data of the different test setup name will be
displayed on the new Data Display window.
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_File Data Display Help
i [categary -]
I B - [
3 MO | Test Results Data Auto Export
% |1 irect Cont ; 2
= |1 biscrete Tl thoose test categones from the left area. |7 Pnabls autareatic dabs sxpart to the specifisd sorage davics
= [ Euseeine
i) 5
1 JC0 Meamcey Deststion for Export
B | Mixedignal |y
= Foldar Path :
= %:_I e i SRS O st
3 Trng vth T choose an apphcation test object from the left area. el
= E * Default Format  Cusstom Format
.0, ‘Satup N’ ['Devce ID(123) ; 4_12_2006 6_24 06 PH]
-
g Idvd Fit Typs
h il ¥ Tast Rt | EasyEXPERT format |
L:m:rn: I~ Compressed Test Apsult | EasyEXPERT format )
Select All o
Unselect All ™ XML Spread Shoet
Display Data T Using X517
Recall AML Siyle Sheet Fie Path
Filter b [ = |
TransportData *F  Import... Extansian of Dutgest Fil ¢ |
Edit ¥ Export As Test Resull... =
B rropenes.. E:.-.-ut f ir\:l\p{nurf] Tost Result ot T
— part As CSV... e —
ble data red the intornal
Ilr:‘j |gvﬂ :: Expont As XML Spread Sheet.. h: E “p ch s it ey
Tmgldvdj|  EXPert Using XSLT... E-I 1
TmgIdVd'  golder Expart... ¥ | __coment
Tmg Vth M
Zero-check [ Auto Export Setting ... 13
| Auto Export on EE] Auto Record OFF

The automatic data export function and the automatic data record function can be enabled or disabled
by using the Test Results Data Auto Export dialog box. This dialog box is displayed by clicking
these indicators or selecting the Results > Transport Data > Auto Export Setting... menu.

The automatic data export function is used to export the test result data automatically to the storage
device you specify. You can specify the destination (storage device), exported file name, and file
type. To set the automatic data export function to enable (set to ON), check the Enable automatic
data export to the specified storage device check box.

The automatic data record function is used to save the test result data to the internal HDD
automatically. This function can be disabled if the automatic data export function is enabled. To

disable the automatic data record function, remove the check from the Enable automatic data record
to the internal storage device check box.

Even if both data export and data record functions are enabled, the functions can be set to OFF by

removing the check from the Record Test Result Data Automatically check box on the Run Option
dialog box.
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Module Self Calibration MO0 Calibration

Calibration

|Modu|e Self Ca\ibration” SMU Zero Cancel]

Module Self Calibration |
| Name | Full Range | Status \ Notes

GNDU+ADC PASS
WGFMU1:RS WGFMU2:RS ~ ---- PASS Unselect All
SMU1:HR P PASS
SMUZ2:HR — PASS
SMU3:MP PASS Start Calibration
™ Full Range
Calibration
£ >
[ Enable Auto Calibration

The Calibration window is opened by clicking the Calibration button. The Module Self Calibration
screen of this window is used to perform the calibration of SMUs. The list area of this screen lists
Name, Full Range, and Status.

Name: Name of module. To select, check the left check box.

Full Range: For the high resolution SMU (HRSMU) connected to the atto sense/switch unit (ASU).
Full range calibration on or off.

Status: Calibration status. Pass or fail.
Notes: Error information when calibration failed.

To perform the self-calibration, specify the modules, open the measurement terminals of the
corresponding modules, and click the Start Calibration button.

Full Range Calibration:
For the HRSMU connected to the ASU. Enables or disables the full range calibration. If this box has
been unchecked, the B1500 does not use the 1 pA range.

Enable Auto Calibration:

Enables or disables the auto-calibration capability. If this box has been checked (function ON), and
the B1500 automatically starts calibration for all modules every 30 minutes if the output switches of
all modules are off for 30 minutes.

NOTE:

To perform calibration correctly, open the measurement terminals. If auto-calibration is enabled, do
not forget to open the measurement terminals or disconnect the device under test from the terminals
after measurement.
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SMU Zero Cancel MO0 Calibration
. 5

Calibration

s Galtration | SHU Zero Cancel | i catbracion |

SMU Zero Cancel

Name | Full Range | 1nA 100pA | 10pA 1pA
O SMUL:HP

O SMU2:HR

O SMU3:HR

O SMU4:HR

1| | (@ smus:nr (a1fa  359fA 1628fA |

[~ Full Range Integration Time:

select Al Unselect All 2

Measure... ‘
3 Close

]

#0] SMU Zero ON

The SMU Zero Cancel screen is used to perform the SMU zero offset current measurement and set
the SMU zero offset cancel function.

This function subtracts the offset current from the current measurement raw data, and returns the
result as the measurement data. This function is used to compensate the error factor (offset current)
caused by the measurement path such as the measurement cables, manipulators, or probe card.

To enable this function, perform the following procedure.
1.Check the left box of the Name column to specify the module to enable this function.

2.Click the Measure... button to perform the zero offset current measurement and wait until the
measurement is completed. The measurement data will be displayed in the appropriate cell.

3.Click the Close button to enable the zero offset cancel function.
To disable the function, uncheck the left box of the Name column, and click the Close button.

Note:

The offset cancel is not available for measurement over 100 nA range. For 10 nA range
measurement, the offset cancel is performed by using the 1 nA range offset value. For measurement
by a range less than 10 nA, the offset value measured by each range is used.

For more information, see online help or User’s Guide.
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CMU Calibration

| Cabibeation

SHU Calbeaon | S Zeva Cancel [ CHU Caltrtion

CMU Calibration

¥ phase Compensation

¥ Open Correction

I Shart Correc i Measure...

Calibration

nnnnn

| [Reference standard value |

1 MHz

 spedify frequencies by range

& Use factory specified frequencies (Default)

" Specify list of calibration frequencies

Open Reference

Model: | Cp-G )

Capaci 0F 8

J il
T

Conductance: [0 5 (]

Short Reference
Model: | Ls-Rs

R

start: | |

stop:| T

steps: | H

scale: | =

Resistance: [0 ohm (]

Load Reference

Model: | Ls-Rs 5
0H (]

[integration Time

50 ahm (]

‘ " Auto Mode & PLC Mode

Factor: [16 (]

13 Cancel

The CMU Calibration screen is used to perform the measurement data correction of the multi
frequency capacitance measurement unit (MFCMU). For the easy way, perform the phase

compensation and the open correction at least. The check boxes left of the Open/Short/Load
Correction and the Phase Compensation are effective after the corresponding measurement is

performed.

Measure...: Opens a dialog box used to perform correction/compensation data measurement. To

perform the measurement, follow the dialog box.

Advanced Options...: Opens the “Advanced Options for CMU Calibration” dialog box used to set
the frequencies for the correction data measurement and the reference values of the working

standard. See the next page.

To perform the open correction and the phase compensation, open the measurement terminals.
To perform the short correction, connect the measurement terminals together.
To perform the load correction, connect your load standard between the high terminal and the low

terminal.
NOTE:

For a more accurate measurement, perform Open/Short/Load correction at the measurement

frequency before starting the capacitance measurement.

If the measurement frequency is not included in the list of default frequencies below, click the
Advanced Options... button and set the measurement frequency on the Frequency area of the

Advanced Options for CMU Calibration window.
Default frequencies:

1k, 2k,5k, 10Kk, 20 k, 50 k, 100 k, 200 k, 500 k, 1 M, 1.2 M, 1.5M,2 M, 25 M, 2.7 M, 3 M, 3.2

M,35M,3.7M,4M,42M,45M, 5 MHz
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Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency ‘ |Reference Standard Value |
# Use factory specified frequencies (Default) Open Reference
¢ Specify list of calibration frequencies Model: | Co-G hd
1 MHz I—AIH Capacitance: |0 F =]
Conductance: |0 5 B
Short Reference
[ete f t Model: | Ls-Rs A
Inductance: [0 H B
" Specify frequencies by range Resistance: |0 ohm B
P I EJ Sl | E] Load Reference
Steps: ] EJ Scale; | J Model: | L5-Rs =
Inductance: |0 H Z]

|]ntegration Time

Resistance: |50 ohm B

‘ " Auto Mode  * PLC Mode Factor: |16 )

oK | Cancel |

This dialog box is opened by clicking the Advanced Options... button, and is used to set the
information required to measure the open/short/load correction data and the phase compensation
data. This dialog box provides the following action button.

OK: Applies the setup changes and closes this dialog box.

Cancel: Cancel the setup changes and closes this dialog box.

Frequency: You can select the measurement frequency setup mode from the following modes.
Measurement frequency setup modes:

Default (Use factory specified frequencies): Usually, select this mode. 23 points are automatically
set. Theyare 1k, 2k, 5k, 10k, 20k, 50k, 100 k, 200k, 500k, 1 M, 1.2 M, 1.5M,2 M, 25 M, 2.7
M,3M,3.2M,35M,3.7M,4M,4.2M,4.5M, and 5 MHz.

Specifies by list: Select this mode when you want to set the frequencies independently. The
frequency must be 1 kHz to 5 MHz. The number of frequencies must be 1 to 101. Click Add to open
a dialog box, and enter the value. For the unnecessary value, highlight the value and click Delete.

Specifies by range: Select this mode when you want to set the frequencies sequentially and
automatically. Specify the start frequency, the stop frequency, the number of steps, and the scale
LINEAR/LOG. The start frequency must be less than the Stop value and at least 1 kHz. The stop
frequency must be more than the Start value and no more than 5 MHz. The number of steps must be
2 to 1001.

NOTE:

If the device measurement frequency is not equal to the correction data measurement frequency,
calculation will be performed automatically to get the correction data for the device measurement
frequency, and the calculated correction data will be used for the data correction of the measurement
data.
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Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency

‘ |meference Standard Value

1 MHz

" Specify frequencies by range

# Use factory specified frequencies (Default)

¢ Specify list of calibration frequencies

T

Start: ’ Ej Stop: i i E]
Steps: ] ;ij Scale; i ;]
|]nIEgrah'on Time

|l"" Auto Mode  # PLC Mode

Factor: 116 izl |

Open Reference

Model: | C0-G -
Capacitance: ;UF—E
Conductance: ;US—‘E]
Short Reference
Model: | Ls-Rs =
Inductance: *IJ H B

Resistance: iU ohm B

Load Reference
Model: | Ls-Rs -
Inductance: ]D H B

Resistance: ]SU ohm B

oK I Cancel ‘

Integration Time area defines the integration time used for measuring phase compensation data or
open/short/load correction data. The number of averaging samples (Mode=AUTO) or the averaging

time (Mode=PLC) is set.

Mode: A/D converter operation mode, AUTO or PLC.
Factor: Factor for the initial value. For details, see online help or user’s guide.
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Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency

Reference Standard Value

# Use factory specified frequencies (Default)

¢ Specify list of calibration frequencies

1 MHz i—EJ
i

" Specify frequencies by range

Start: ] E Stop: i i E]

Steps: ] jj Scale; J ;]
|]nIEgrah'on Time ‘
‘ " Auto Mode  * PLC Mode Factor: ]16 )

Open Reference

Model: | C0-G -
Capacitance: ;UF—E
Conductance: ;US—‘E]
Short Reference
Model: | Ls-Rs =
Inductance: {IJ H B

Resistance: iU ohm B

Load Reference

Model: | Ls-Rs -
Inductance: ]D H B

Resistance: ]SU ohm B

oK I Cancel ‘

Reference Standard Values area provides the following entry fields used to set the reference values
of the open/short/load standard. If you use the standard, enter the reference values to the entry fields.

OPEN Reference: Capacitance and Conductance. If you do not use the reference, enter 0 in the both

fields.

SHORT Reference: Inductance and Resistance. If you do not use the reference, enter 0 in the both

fields.

LOAD Reference: Inductance and Resistance
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Configuration

Main Frame

Configuration

{ilfain Frame | Modules | Switching Matrix | SMU/PG Selector | Event Log

|9yshem Information |

Meodel Identification: |B1300A Line Frequency: |30Hz -
EasyEXPERT Rev.: |E.A.03.20.2008.091 Firmware Rev.: |E.A.03.20.2008.091!

Host ID: |00083bb7f1de

Main Frame Diagnosis |

| Item Status
Trigger I/O
Digital I/O
Touch Panel Switch Unselect All
LCD Z

High Voltage LED

Measurement LED

Front Key

Start Diagnosis

EEEEEEE

i

The Configuration window is opened by clicking the Configuration button, and is used to display the
system information and event log, as well as to perform diagnostics and self-test.

The Main Frame screen is used to display the system information and perform diagnostics.
Model Identification: Displays the instrument ID. B1500A.

Line Frequency: Sets the power line frequency, 50 Hz or 60 Hz.

EasyEXPERT Rev.: Displays the revision number of the EasyEXPERT.

Firmware Rev.: Displays the revision number of the B1500 firmware.

Host ID: Displays the host id of the B1500A internal computer.

Main Frame Diagnosis: This area lists Iltem and Status.

Item: Name of diagnostics item. To select, check the left check box.

Status: Diagnostics status. Pass or fail.

To perform diagnostics, specify the items to perform and click the Start Diagnosis button. A dialog
box is opened. Follow the dialog box to perform the diagnostics. Some items need your judgement,
pass or fail. Also you will need to connect an adapter, press keys, check LEDs, and so on.

The Host ID is important for the B1540A-002 users and the B1541A-002 users. It is necessary to
activate the EasyEXPERT or Desktop EasyEXPERT Software Plus features. For details, see the
Software Entitlement Certificate.
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Modules

Configuration

Configuration
Main Frame Modules ]Swrtching Matru(] SMU/PG Selector | Event LUg]
Slot Configuration |
| Slot | Module Type \ Name | Status | SCUU | Notes
11 B1500A GNDU+ADC PASS
1 B1530A WGFMUL:RS,WGFMU2:RS PASS
2 Bi517A SMU1:HR PASS Ll
3  B1517A SMU2:HR PASS
4 B1511A SMU3:MP PASS
Start
Self Test
< ™
Accessory Configuration
Status LED:

The Modules screen is used to perform self-test of modules.

Slot: Slot number where the module is installed. To select, check the left check box.

Module Type: Module model humber

Name: Module name

Status: Self-test status, Passed, Failed, Recovered, or ---- (self-test has not been performed)

SCUU: Specifies if the module is connected to the SCUU.
Notes: Error information when the module self-test failed.

To perform self-test, specify the modules, open the measurement terminals of the corresponding
modules, and click the Start Self Test button.
Recover Module button is for the service use only. This button makes the failed modules respond
again. This button does not solve the problem that causes the Failed status.

Status LED: Enables (ON) or disables (OFF) the status indicator (LED) of the ASU (Atto Sense and
Switch Unit) and the SCUU (SMU CMU Unify Unit).
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ASU Configuration

Configuration
Main Frame | Modules ASU IS','."rtching Matrix | SMU/PG Selector | Event Log |
ASU List |
\ Slot | Module Type | Name | ASU Serial Number | ASU I/O Path \
5 B1517A/E5288A SMU3:HR/AS JP10M00172 SMU
6 B1517A/E5288A SMU4:HR/AS JP10M00300 SMU
* NOTE: The specifications are satisfied and
guaranteed for the exclusive combination of the ASU ASU I/0 Path: |SHU j'
and the HRSMU. So confirm the serial number of the
ASU and connect it to the dedicated HRSMU properly.

The ASU screen is available if the B1500A installs the HRSMU connected to the ASU (Atto
Sense/Switch Unit), and shows the ASU information.

Slot: Slot number
Module Type: Type of module
Name: Module name or SMU name

ASU Serial Number: Serial number of the ASU registered as a pair with the HRSMU. This cell
displays an error message instead of the serial number if unpaired ASU is connected.

ASU 1/0 Path: ASU input to output connection, SMU or AUX

If the ASU 1/O Path field is set to SMU, the ASU makes the path from the ASU Force input to the
ASU output.

If the ASU 1/O Path field is set to AUX, the ASU performs automatic switching in every test. The
ASU makes the path from the AUX In input to the ASU output for the test without the HRSMU and
makes the path from the ASU Force input to the ASU output for the test with the HRSMU.
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Switching Matrix Configuration
General Information |
Switching Matrix Type: |B22DDA Fernto Leakage Switch MainFrame
Start
GPIB Address: |22 B poll Self Test

B2200A/B2201A Input Port Configuration [ Extended Configuration ~ ||

SWM IN1: | SMUL:HP ~| I Kelvin SWM IN9: i

SWM IN2: o SWM IN10: -

SWM IN3: | SMUZ:HP ~| I Kelvin SWM IN11: o

SWM IN4: - SWM IN12: -

SWM IN5: | SMU3:HR =| I Kelvin SWM IN13: | CMUL:MF | 7 cMu

SWM ING: - SWM IN14: -

SWM IN7: | SMU4:HR ~| I Kelvin

SWM INS: -

The Switching Matrix screen is used to establish the GPIB connection with Agilent
B2200A/B2201A/E5250A switching matrix and define the B2200A/B2201A/E5250A input port
connections.

Switching Matrix Type: Displays the type of the switching matrix or No Switching Matrix.

GPIB Address: Specifies the GPIB address of the switching matrix. 1 to 30.

Poll: Confirms if the switching matrix of the specified GPIB address is connected to the B1500A.
Start Self Test: Starts the selftest of the switching matrix.

SWM IN#: Switching matrix input ports. Enter the label used to specify the input port to the right
entry field. The port name and the connected module name can be the label. The character : (colon)
cannot be used. Checking the Kelvin check box grays out the coupled even number port. Checking
the CMU check box grays out SWM IN10 for the E5250A or SWM IN14 for the B2200A/B2201A.
The input ports IN11 to IN14 are not available for the E5250A.

Kelvin: Check this box if this port is used for the Kelvin connection.

CMU: To perform capacitance measurement through the switching matrix, check this check box and
set CMUL:MF to the SWM IN9 for the E5250A or the SWM IN13 for the B2200A/B2201A. And
connect MFCMU to the Input 9 and 10 of the E5250A or the Input 13 and 14 of the
B2200A/B2201A. To perform capacitance compensation, see User’s Guide.

Extended Configuration: Opens the Extended Configuration dialog box. See the next page.

Note: Standard revision of EasyEXPERT does not support the E5250. The E5250 control is a feature
of the B1540A-002/B1541A-002.

Note: The E5255A installed in the E5250A is not supported.
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Extended Configuration

Configuration
-rx(mdm! Configuration i

[Save As Hardware Profile |

T save cument configuration as Hardware Profile,
| chick this button.

Start Mo Compensation
Self Test
B2200A/ B2201A
= # Select
|| Extended Configuration v|| e =
i cabile: [16494a.002 {3 m) -

X " User Compensation Data File
- | =
jv
FHI50A
AUL:MF = I cMu " Usaer Compensation Data File (F5250A)
- H =
-

Length:

Triaxial Cable: ] Meters
User Trimdal Cable: ] Meters
User Coaxal Cable: ] Meters

Oose |

This dialog box is opened by clicking the Extended Configuration button in the Configuration
window Switching Matrix screen.

Save as Hardware Profile is used to save the hardware profile that is the B2200A/B2201A/E5250A
hardware configuration and the measurement module connection. Click the Save button to save the
present hardware profile. The hardware profile can be made for each workspace individually.

CMU Compensation is used to select the compensation mode of the capacitance measurement using
the B2200A/B2201A/E5250A. Click one of the radio buttons, No Compensation, Select, and User
Compensation Data File. For the capacitance compensation, see User’s Guide.

* No Compensation:

Select this radio button if you do not need the capacitance compensation. The raw data without
compensation is displayed and saved.

* Select:

Select this radio button to perform the capacitance compensation for the path from the
B2200A/B2201A input ports to Agilent 16495F/G connector plate or Agilent B2220A probe card
interface. The data after compensation is displayed and saved.

DUT I/F field is used to specify the model number of the path you use. The selections are the
16495F/G and B2220A.

Cable field is used to specify the model number of the cable from the B2200A/B2201A output to the
DUT I/F. The selections are the 16494A/B/C-001/002/005. This mode cannot perform the
capacitance compensation for the cables to positioner/manipulator or the probe card.

» User Compensation Data File:

Select this radio button to perform the capacitance compensation for the path from the
B2200A/B2201A/E5250A input ports to the end of positioner/manipulator or probe card. See User’s
Guide. The data after compensation is displayed and saved.

Note: Standard revision of EasyEXPERT does not support the E5250. The E5250 control is a feature
of the B1540A-002/B1541A-002.

Note: The E5255A installed in the E5250A is not supported.
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SMU/PG Selector Configuration

16440A SMU/PG Selector

¥ Enable SMU/PG Selector

SMU Assignment: Input/Output Path:

Selector CH1:|5MUZ:HR _x|normaly PeU (AUX) x|
Selector CH2: |5MU3:HR. || Alvays sMU [
Selector CH3: |5HU4:HR. _>||mormaly PGU (AUX) =]
Selector CH4: |5MUS:HR || Always smu ]

The SMU/PG Selector screen is used to specify the input connection and the channel connection
status of the Agilent 16440A SMU/PG selector.

Enable SMU/PG Selector: Check this box to use the selector.
Selector CH1/CHZ2: Indicates the channels 1 and 2 of the first selector respectively.
Selector CH3/CH4: Indicates the channels 1 and 2 of the second selector respectively.

SMU Assignment: Specifies the SMU connected to the SMU input of the selector channel CH1,
CH2, CH3, or CH4.

Input/Output Path: Specifies the connection status of the selector channel CH1, CH2, CH3, or CH4.
Always SMU: Makes the selector channel “SMU on” state.

Normally PGU (AUX): Performs automatic switching in every test. The selector channel normally
makes the “PGU on” state and makes the “SMU on” state only for the test which uses the SMU
connected to the Input SMU terminal.

The CH1 and CH3 also provides the “PGU open” state which is set by using the Advanced window
of the Measurement Setup.
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SMU/PG Selector

o Easy to switch between SMU and PGU
o Solid state relay

16440A Selector

Input SMU

Channel 1 ToDUT
Input PGU
Input SMU

Channel 2 . ToDUT
Input PGU ©

SW1 & SW2 : Mechanical Relay
v Flash Memory Test SW3: Solid State Relay
v Transistor photomos

The selector has two channels as shown above. Each channel has two ports (SMU and PGU).
External pulse generators can also be connected. The connectors are Triax for SMUs and outputs,
and BNC for PGUSs.

Up to two selectors (four channels) may be required for some reliability tests such as Flash
EEPROM.

As a special design for Flash memory, a solid state relay was added to float the drain. This
eliminates wear and tear of millions of closures that would occur with a mechanical relay.
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Event Log

Configuration

4/11/2006 4:48:33 PM

Event Log |
Date/Time 1 Message 1 D ] Process User Host
4/12/2006 3:00:35 PM  Configuration query completed. 110001 StaDaemon B1500user B1500A-0...
4/12/2006 3:00:29 PM  Service started successfully. 102001  StaDaemon  B1500user B1500A-0...
4/12/2006 2:25:56 PM  Service stopped successfully. 102002 AppSetup B1500user B1500A-0...
4/12/2006 2:00:41 PM Service started successfully. 102001 AppSetup B1500user B1500A-0...
4/12/2006 2:00:38 PM  Service stopped successfully. 102002  StaUpd B1500user B1500A-0...
4/12/2006 2:00:37 PM  Service started successfully. 102001  StaUpd B1500user B1500A-0...
4/12/2006 1:52:48 PM  Service stopped successfully. 102002 StaDaemon B1500user B1500A-0...
4/12/2006 12:44:00 ... Configuration query completed. 110001 StaDaemon B1300user B1500A-0...
4/12/2006 12:43:51 ... Service started successfully. 102001 StaDaemon B1500user B1500A-0...
4/12/2006 12:40:29 ... Service stopped successfully. 102002 AppSetup B1500user B1500A-0...
4/12/2006 12:14:57 ... Service started successfully. 102001 AppSetup B1500user B1500A-0...
4/12/2006 12:14:53 ... Service stopped successfully. 102002  StaUpd B1500user B1500A-0...
4/12/2006 12:14:52 ... Service started successfully. 102001 Stalpd B1500user B15004-0...
4/11/2006 6:30:48 PM  Service stopped successfully. 102002 StaDaemon B1500user B1500A-0...
4/11/2006 6:50:47 PM  GPIB timeout occurred.Int... 103008 StaDaemon B1500user B1500A-0...
4/11/2006 4:51:15 FM StaDaemon B1500user B1500A-0...

StaDaemon B1500user

B1500A-0... [

The Event Log screen displays the event log.
Date/Time: Displays date and time of the event.
Message: Event message

ID: Process ID of the event

Process: Process name

User: User name. Windows login name.

Host: Host name of the B1500

The Refresh button refreshes the event log.
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XSLT Filters

File _Data Display _Melp

: [Cotgory = | (@ Trmg ldvd Idvg
T ~ [Device Parameters

OS5

Gimes contst Hold: [3 ¢ L]
Discrete

[ Setect XL Style Shoot Fite E

| Awiicason Test

| Export in My Format
My Format:
[EiSProgram Fies AglentiE1 SO0 EasyEXPER T\Uites Nk Timeas_inden_mata-cov. i (_frowse )

Click this button

F 4:34:20 . -
az0:0| Mg 2
7 3:00:41 WMot Fad e ] [ ]

Highlight this line

The XSLT (XSL-Transformation, eXtensible Stylesheet Language Transformation) filter files are
used to export test records. The fifteen filter files listed below are stored in the
C:\Program Files\Agilent\B1500\EasyEXPERT\Utilities\XSLT folder.

The following filter files are used for exporting the measurement data only.
meas-csv.xsl, meas-tab-sv.xsl, meas-xmlss.xsl

The following filter files are used for exporting the measurement data with the index.
meas-index-csv.xsl, meas-index-tab-sv.xsl, meas-index-xmlss.xsl

The following filter files are used for exporting the measurement data with the meta data.
meas-meta-csv.xsl, meas-meta-tab-sv.xsl, meas-meta-xmlss.xsl

The following filter files are used for exporting the measurement data with the index and the meta
data.
meas-index-meta-csv.xsl, meas-index-meta-tab-sv.xsl, meas-index-meta-xmlss.xsl

The following filter files are used for exporting all data including the test setup.
csv.xsl, tab-sv.xsl, xmlss.xs

Where, the meta data contains the test name, the setup name, the record time of the test results, the
device 1D, the counter number, the flag of the test results, and the remarks on the test results.

Filter files that contain xmlss in the file name export test record in the XML Spread Sheet format.
Filter files that contain csv or tab-sv in the file name use a comma or a tab for the data separator.
For more information, see online help or User’s Guide.
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To Enable System Controller

Agilent 10 Library Connection Expert
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To control external GPIB devices, the B1500A must be set to system controller. Exit the EasyEXPERT, and
close the Start EasyEXPERT window. After that, launch the Agilent Connection Expert by clicking Start, All
Programs, Agilent 10 Library Suite, and Agilent connection Expert.

On the Agilent Connection Expert, change the GPIB configuration of the B1500A.
«Select GPIBO.

«Click Change Properties... button.

«Change GPIB address to 21 that is the typical address number for the system controller.
*Check System controller box.

«Click OK button.

*Reboot the B1500A.
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To Start Desktop EasyEXPERT

[ GPIB Communication
" Online
VISA interface I m
e R onn GHIB address: m

Start EasyEXPERT  Offine

Model: |B1SO0A  »

Ok Cancel

Database Backup Creation Wizard

Database Restoration Wizard

- Mowe To

File | Oipticn
E secution Mo
EasyEXPERT Database »

Backup EasyEXPERT Database
e
Move EasyEXPERT Database

EasyEXPERT Database Path:

Important: [ #sers Browse..,
To set the same configuration as the B1500A,
copy the following file from B1500A to your PC. _ Cancal |

The location must be the same. 2

\Documents and Settings\All Users\Application Data\Agilent Technologies, Inc\EasyEXPERT\UnitConfigB1500A.xml

To open the Start EasyEXPERT window, click Start > Programs > Start EasyEXPERT menu. This
window provides the Option menu used to open the following dialog box.

Gpib Communication:

Select Online if the B1500A, 4155B/C, or 4156B/C is connected to your computer and you want to
control it via GPIB. Or else select Offline.

Database Backup Creation Wizard:
Use this wizard to create the EasyEXPERT database backup (xdb file).

Database Restoration Wizard:
Use this wizard to restore the EasyEXPERT database backup. The wizard can restore the xdb file or
the backup which is a copy of the folder that contains the EasyEXPERT database.

EasyEXPERT Database:
Specify the EasyEXPERT Database path if you want to move the database to the other folder.

To launch Desktop EasyEXPERT, click the Start EasyEXPERT button.

Note: Desktop EasyEXPERT supports most of the EasyEXPERT functions. However, some
functions are not supported on an external computers due to differences in hardware and so on.

Note: For the installation procedure, see the readme file stored in the Desktop EasyEXPERT CD-
ROM.

Note: For the offline mode. To use the same module configuration as the B1500A, copy the
UnitConfigB1500A.xml file to your PC which the Desktop EasyEXPERT runs. The file is stored in
the B1500A hard disk drive. The location is shown in the slide. The file must be copied to the same
location in your PC.
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To Use 415x Setup File Converter

- == -
EC = | A | meort
ae | 78" rrei l”‘ f
ECHE m—
Ga CramE = =
4155/4156 setup file EasyEXPERT setup file
(file extension: MES or DAT) (file extension: XTS)

b[SetupFiIeConverter.exep

Execution example:

C. \ Mydat a>Set upFi | eConverter. exe setupl. dat
C. \ Mydat a>Set upFi | eConverter. exe *. nes

You can reuse the 4155/4156 setup file (MES file or DAT file) for the test using EasyEXPERT. This

is realized by Setup File Converter which has the function to create the XTS file by converting the
MES or DAT file to the EasyEXPERT format. This executable file is stored in the following folder.

C:\Program Files\Agilent\B1500A\EasyEXPERT\Utilities

You can execute the setup file converter on the Command Prompt as shown below. If you want to
use the Windows desktop instead of the Command Prompt, see the next page.

1. Create your working folder (for example, C:\415xdata).

2. Copy your MES or DAT files to this folder.

3. Copy SetupFileConverter.exe file to this folder.

4. Launch the Command Prompt.

5. Go to your working folder (for example, C:\> cd 415xdata).

6. Execute SetupFileConverter.exe as shown in the following example.
C:\415xdata> SetupFileConverter.exe *.MES

This example converts all MES files in your working folder to the EasyEXPERT setup file format,
and creates the XTS files in this folder.

Note: If you execute the setup file converter without the parameter, the help message will be
displayed.

Note: The setup file converter provides some options. See User’s Guide or online help for the
options.
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To Use 415x Setup File Converter
1. Drag and drop the shortcuts of the MES/DAT file on

nthe shortcut of the Setup File Converter.

3. XTS file and shortcut are created.

2. File conversion is executed and system message is displayed.
msetwprieConverter _lo|x|

SetupFileGonverter.exe : Uersion A.A3Z.18

Start Conversion : E:\Documents and Settings\nGIL4155.RGILENT\Desktup\R.‘
ES1.DAT

ExportFile ¢ E:\Documents and Settings\AGIL4155.AGILENT“\Desktop-RE|

Setuplersion : HP4155_CB2 .24
Conversion successfully completed.

——— Press Enter key to guit.

You can perform the file conversion on the Windows desktop as follows.

1. Create a shortcut of the SetupFileConverter.exe on the desktop.

2. Copy your MES/DAT files to the desktop.

3. Drag and drop the shortcuts of the MES/DAT files on the shortcut of SetupFileConverter.

This starts the file conversion and displays the system message. And if the conversion is completed
successfully, the setup file converter creates the XTS files and the shortcuts on the desktop.

Note: The setup file converter provides some options. See User’s Guide or online help for the
options.
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=Y Aeilent 4155/4156 Setup File Gonverter for Windows

File  Help

- FSelect | P Convert 3 Glear

To Use 415x Setup File Converter

Click [Start] — All Programs — Agilent B1500A EasyEXPERT
— 4155,4156 Setup File Converter

Create XTS for:

& B1500A
O 41558/C
) 41558/C with HPSMU
O 4156B/C
) 41568/ with HPSMU

Selected Files:

C¥YTHGM.MES

Start Conversion @ C:¥VTHGM.MES

ExportFile T Cr¥VTHGM.xts

SetupVersion : HP4155_C03.10
Conversion successfully completed.

To create XTS file:

The following procedure converts the 4155/4156 setup file (DAT or .MES) and creates the .XTS file
in the folder the setup file is stored.

1. Click Select icon, or click File > Select Files to open the Select 4155/4156 MES Files or DAT

Files dialog box.

2. Specify the 4155/4156 setup files to convert. Multiple files can be selected.
3. Click Open on the Select 4155/4156 MES Files or DAT Files dialog box.

4, Click Convert icon, or click File > Convert Files.

To read XTS file, use the import function to read the created .XTS file on the EasyEXPERT.
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SPGU Control and Applications

In This Module

* High Voltage SPGU

* SPGU Control

* Pulse Generator Mode
* Charge Pumping

* Flash Memory Test

* ALWG Mode
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High Voltage SPGU

High Voltage Semiconductor Pulse Generator Unit

« 2 channels per module

« Output impedance: 50 ohm

« Amplitude: +/-40 V (open load), +/-20 V (50 ohm load)
« PG mode or ALWG mode

« Free run, duration, or count

« 2- or 3-level pulse output for each channel in PG mode
« Pulse switch

« Automatic voltage level adjustment

50 ohm Pulse switch
SPGU
D, W e ouT
J_|_|— 3-level voltage pulse v Charge Pumping
v Flash Memory Test
J\/‘— ALWG voltage  AC Stress

High Voltage Semiconductor Pulse Generator Unit (HVSPGU) is specially designed for
semiconductor test. Most pulse generators' output voltage is less than 10 V with 50 ohm impedance.
However, in semiconductor test (especially reliability test) 30 to 40 V capability is required for the
flash memory write/erase cycle test. The HVSPGU output voltage is 40 V at open load.

The HVSPGU provides two output mode, PG mode and ALWG mode. In the PG mode, the
HVSPGU can output 2- or 3-level voltage pulse. And in the ALWG mode, it can output an arbitrary
linear waveform voltage.

The pulse switch is built into the SPGU channel for performing the endurance test of the NOR type

flash memory effectively. The SPGU channel can output the drain pulse for the write operation and
make the open status for the erase operation in one pulse period.

The output impedance of the SPGU is fixed to 50 ohm. However, the SPGU channel can output the
voltage close to the setting value if you specify the load impedance of DUT properly. Because the
channel automatically adjusts the output level by using the specified load impedance value.
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High Voltage SPGU

Rear View

Connect 16493Q cables to make
synchronization of multlple SPGUs.

®| | Slot 2 |(Slave SPGU)

TN & our REF T N S\"NG UI.IT

'% @K\ O ©.07F5" 0 @ 6| siot1 |(Master SPGU)

[ :

LED fg!show the output switch status

The B1500A can install the maximum of five SPGUs. The SPGUs must be installed in the contiguous slots
from the slot 1. Where the SPGU installed in the slot 1 is the master SPGU. The channel number PG1 is
assigned for the Output 1 of the master SPGU. And the following numbers are assigned for the subsequent
channels.

The SPGU has seven connectors.

The Output connectors are for the SPGU signal output.

The Ref In/Out and Sync In/Out connectors are for making synchronization of multiple modules.

The Trig Out connector outputs the trigger signal used to make synchronization with the external instruments.

If the multiple SPGU modules are installed, the 16493Q cables must be connected between the Ref Out
connector and the Ref In connector and between the Sync Out connector and the Sync In connector as shown
above. This is necessary to synchronize the module outputs.
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High Voltage SPGU

Pulse Switch CLOSE

o

Drain

Write

CLOSE
<:> o—5 [Tanar |
SMU
|:| Substrate L=
Gate

Source

Pulse period

Write Erase

e |

SMU
Substrate L= l

CLOSE |:|
U L OPEN —

The pulse switch is the built-in high speed analog switch to open/close the SPGU output for each
channel. This switch is used in the write/erase cycle of the NOR type flash memory cell test. This
dramatically improves throughput of the endurance test (write/erase lifetime reliability test). The
SPGU channel can output the drain pulse for the write operation and make the open status for the

erase operation in one pulse period.
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High Voltage SPGU

Effects of Load Impedance

Output Impedance

Vset '

Pulse Source

Vset: Setting voltage with open load

Rdut

Vdut =Vset x ——M—
Rdut + 50

The voltage actually applied to the DUT depends on it’s impedance. This behavior is very common among the
instrumentations like DC power supply and pulse generators. In this meaning, SMU is very special because
the output of SMU is controlled by the feedback loop from the voltage monitored by the sense terminal.

If Rdut is large enough (ex. gate terminal) compared with 50 ohm output impedance, Vdut is almost equal to
Vset.

If Rdut is not so large (ex. drain terminal at the ON state), the difference between Vdut and Vset is not
negligible. In the case of 1 mA current with 1 V bias (= 1 kohm), the difference will be about 5 %.

The SPGU provides the function to adjust the output voltage automatically. To use this function properly, the
load impedance of DUT must be registered and it must be accurate. Then the SPGU can apply the voltage
near the setting value to the DUT.
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High Voltage SPGU
Effects of Load Impedance
Mismatch of load impedance |
setting may cause the error of Actual
i JU
applied voltage to the DUT. - Expected
Setup: 1V output, 50 Q load <. N S )
Actual load: 1 MQ > 2V output = |

5 Expected

1y

JU

iy Actual

A1

Iﬂ o
Setup: 1V output, 1 MQ10ad b senos o wmim
Actual load: 50 © > 0.5 V output = |

Here is the example of the voltage error due to the mismatch of the load impedance setting.

If the load impedance is set to 50 ohm when the actual load impedance is 1 Mohm, the voltage actually applied
to the DUT is about double the setting value. If the load impedance is set to 1 Mohm when the actual load
impedance is 50 ohm, the voltage actually applied to the DUT is about half the setting value. So the load
impedance value must be accurate to apply the voltage near the setting value to the DUT.
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High Voltage SPGU
Agilent 16493P BNC (m) - SMA (m) Cable

« To connector plate
* To 16442A/B test fixture
e To 16440A SMU/PGU selector
« To E5288A ASU
(Atto Sense and Switch Unit)

Agilent 16493P is the connection cable for the SPGU outputs.
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SPGU Control

E?}E;Ei [@]spcu C.c.)ntrol Setup Name: [5PGU Control
------ Channel Definition
CSD':;’L;I add | Delete | Up | Doy |
Unit: ¥ Name: Mode:
[el SEE =] [sPauvt = [vPuse =l Mode: VPULSE or ALWG
& |SPGU2:H\I =l |5DGuv2 = |\IPULSE =l
T6440A Selector
SMU Input— Biars Holdd afber Moosurement: [0 -]
1 —
) [Femiconduetor Reliys [ 16490/ S/ PG Seiecior)
| o Ot put
CH1 i/ @ CH 1= ﬁF-’-uT -I =T FGIODFN -
chosa
Rie e
PGU Input —
SMU Input—— Check here to display the Percent of Progress vs. Time plot.
1) . . .
© Check here to display the Time data list.
CHZ = Output
i D SPGU Setup F\ngress Monitor
PGU Input ——i *_
Pulse/aLWGE Advanced Graph: % of Progress I List: Time Data
@ Mechanical relay

(81 Semiconductor relay

The SPGU can be used in the classic test other than the C-V Sweep and the Switching Matrix
Control. So you can use the SPGU output while a measurement is performed. If you need the SPGU
output only, use the SPGU Control classic test. In this classic test, the single button triggers the
SPGU outputs, and the Data Display works as the progress monitor.

The SPGU provides two output mode, VPULSE (pulse generator mode) and ALWG (arbitrary linear
waveform generator mode). And the same mode must be set to the all output channels. The B1500A
can have the maximum of ten SPGU output channels.

The Advanced button opens the Advanced Setup dialog box. The dialog box is used to set the after
measurement settings and the 16440A selector semiconductor relay setting.

After Measurement Setting:

*Bias Hold after Measurement: Bias hold function ON or OFF.
Semiconductor Relays (16440A SMU/PG Selector):

*CH1: Default or PGU OPEN

*CH3: Default or PGU OPEN

The fields define the selector channel’s switch condition during the measurement. Default means the
setting defined on the SMU/PG Selector screen of the Configuration window.
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SPGU Control
SPGU Pulse Setup

SPGU Control Sl et osration wontz | D
SPGU Setup Period: 1w L]  FREE RUN T PULSE COUNT '
" BURATION I
Pulse/ALWE Advanced Y ]
SR setup view order:
ot |Primary ke Rricitinnal Pilte
e o Base: oV uf O]
b = I T
C EEEmTTTE e e 5 ’71
Width: o ] I’}
Tipe: L ¢ PO L} :
Buttons on pr g <l 2o ]
Measurement Setup it [Primary Puie ﬁﬁ\du-lhmul Pl
screen of a Classic Test| = mife a4
(= mww Delay: f [] ]
Range withs [[ore Bl W]
Toe: Leading: [0 o ] &
ADC T R
Integ
Ad-
wanced
SPiU ‘
Pulse
Setup —

If the SPGU output mode is set to VPULSE, the Pulse/ALWG button opens the SPGU Pulse Setup
window. This window is used to define the voltage pulses applied by the specified SPGU channels.
For the setup parameters, see later page titled Pulse Setup Parameters of Pulse Generator Mode. In
the other classic test, this window is opened by the SPGU Pulse Setup button on the Measurement

Setup screen.
The Pulse Switch button opens the dialog box used to set the pulse switch operation.
The Load Z button opens the dialog box used to set the load impedance of the DUT.
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SPGU Control

Pulse Switch Setup

50 ohm Pulse switch

o
Y

Pulse Switch Setup
Pulse Switch

a\% o—T

J_I_r 3-level voltage pulse

SPGU
ouT

Pulse period

Delay

Write

—

e

J_L OPEN

Erase

Unit:

VName: SW Sync: Delay:

Width:

Normal:

|sPGULHY B|[sPaliv ( & [ENABLE ~los

100 ns |

E)

|sPGUZ:HY 8[sPauv2 \EUM

e

Default setting of the switch is “CLOSE”
Close

You can set the pulse switch operation on the Pulse Switch Setup dialog box. Set the SW Sync to
ENABLE to use the pulse switch. The delay time is the time from start of pulse output to changeover
of pulse switch. The width is the duration to hold the switched state of the pulse switch. And the
normal field specifies the pulse switch status OPEN or CLOSE at the normal state which is not the

switched state.

Recommended width value is more than 100 us because of the time lag for changeover.
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SPGU Control

Load Z Setup

Unit: ¥Name: Load Z:
[sPGULHY B|[sPauvy ( ‘=[S0 ofm

Output Impedance |SPEUZ:HY Blfsrauvz ‘=[50 ohm
Setting (default=50 ohm)

Vset: Setting voltage with open load

You can specify the load impedance of DUT on the Load Z Setup dialog box. By setting the load
impedance value accurately, the SPGU can apply the voltage near the setting value to the DUT.
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SPGU Contro

SPGU ALWG Setup
SPGU Control

SPGU Setup

Pulse/ALWE Advanced

L,

Buttons on
Measurement Setup
screen of a Classic Test

Range

ADC /
Trteg

Ad-
vanced

o

SPGLI
ALWG
Setup

_
Operation
Load Z
% FREE RUN {~ SEQUENCE COUNT |1 EI
' DURATION 1us B
ALWG Setting |
ALWG Source: Ia B
Clasge

Piilze:
Siviteh

/

This button opens the Define ALWG
Waveform window used to define the
ALWG output sequence.

If the SPGU output mode is set to ALWG, the Pulse/ALWG button opens the SPGU ALWG Setup
window. This window is used to define the arbitrary linear waveform voltage applied by the
specified SPGU channels. In the other classic test, this window is opened by the SPGU ALWG

Setup button on the Measuremen

t Setup screen.

The Load Z button opens the dialog box used to set the load impedance of the DUT.
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Pulse Setup Parameters

Pulse Generator Mode

Delay time

Pulse period
Pulse width
Leading time Trailing time
Pulse peak
P A -90%
Amplitude
P P e \ 10 %
Pulse base

The pulse setup parameters are defined as shown above.
The pulse leading time and trailing time are defined as the voltage transition time between 10 % and

90 % of the amplitude. Minimum setting value is 8 ns.
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Pulse Generator Mode,

Pulse output example:

1008/ 2070r SO0t Swp § § sS0e

2. SPGU Pulse Setup window

SPGU Pulse Setup Uty Mena
Global Settings |Operalion ‘If' | Pm:::nﬁg ”'52.’" | an: | Sge war |
Period: |1 ms 8| | © FREERUN & PULSE COUNT 10 H| s
" DURATION B
Pulse Settings
SPGU setup view order:
Unit: [Primary Pulse [Additional Pulse |
[spu1:HY &| Base: [0V & ]|
Nae peak: [500 mv ol |
T —— LT [os & |
width: [500 us & | i
Type: " R ]
Leading: [100 us 8| g| - H
e — ol i ' Pulse period:

3. Pulse setup parameters

To apply the SPGU pulse output, set the pulse setup parameters, specify the Operation, and click the
Single button.

The following operations are available.

PULSE COUNT: SPGU outputs the specified number of pulses. Specify a number within the range
of 1 to 1000000.

DURATION: SPGU continues the output until the specified time elapses. Specify a time within the
range of 1 us to 31556926 s (1 year).

FREE RUN: SPGU continues the output until the measurement is completed or stopped. This
operation is not available for the SPGU Control classic test.

To set the pulse setup parameters,

1. Display the SPGU Control classic test screen or the Measurement Setup screen of the other classic
test.

2. Open the SPGU Pulse Setup window by clicking the Pulse/ALWG button on the SPGU Control
classic test screen or the SPGU Pulse Setup button on the Measurement Setup screen.

3. Set the Type, Period, and Primary Pulse parameters. For the pulse setup parameters, see the
previous page.

For the 3-level pulse, select the 3-Level Pulse type. Then the Additional Pulse fields will be active.
The 3-level pulse is defined as sum of two 2-level pulses, Primary Pulse and Additional Pulse.
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Pulse Generator Mode

3-Level Pulses

» Every channel can output 3-level pulse
80 Vp-p within +/-40 V window (at open load)

» Pulse width and level of each channel can be set individually.

SPGU10

SPGU3

SPGU2

SPGU1

ERER

Up to 10 output channels can be installed in one B1500A and each channel can output 3-level pulse with a

maximum output voltage.
The channels are independent. So the channels can apply the different pulses. However, the pulse period
value is common for all channels.
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Charge Pumping

j%Gate
Source Drain
| oxide |
n+ P, { n+ B
p @
lSubstrate SMU PGU
Icp
SMU

or

Charge pumping is a type of hot carrier measurement. It provides direct measurement of interface

states and an indication of electron and hole trapping.

The gate of the MOS transistor is connected to a pulse generator. The current (Icp) is caused by the
repetitive recombination of minority carriers with majority carriers at the silicon-silicon oxide

interface.
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Charge Pumping

Gate Waveforms

Square Pulse

Triangle Pulse

Trapezoidal Pulse

Three Methods of Charge Pumping

Voltage

UIEEL
/NN

NNV

Time

Square Pulse

The base of the pulse is stepped from well below gate threshold to well above. At each step, the
substrate leakage current is monitored. The flat part of the resultant curve is proportional to

interface-state density.

Triangle Pulse

The frequency of a constant height triangle pulse is increased in steps. At each step, substrate
leakage is measured. Average interface state density and capture cross-section are measured by this

method.

Trapezoidal Pulse

A fixed height pulse is applied to the gate. By varying the leading/trailing edge of the pulse, you can

plot interface-state density vs energy.
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Charge Pumping

Start
IntegTime: ,m . Drain: ’W
Gate: W { :|
(" Calculates Vbase ) PulseLevel: F0v ] g Subs 6
& VhaseStart: m
Sets meas. parameters Vbasestop: [0V 7 . é
|_to I_sub sampling test ) |:] E]

l

| sub Sampling meas. PulsePeriod: ,m Source: ’W Subs: ’W
by applying Vg pulse PulseDelay: [z | vs: v 8 [T veubs: [V 8
DutyCycle: p0.0% B| Istimit: [L00me 8] e IsubsLimit: [1.0000s 8|

l LeadingTime: [20rs 8|

[Records Isub and Vbase] TrailingTime: Fors 8]

Y
More Vbase?

N

Looping of classic test for each
base step of Gate pulse.

Calculates IcpMax & NSS
Plots Icp vs Vbase

Icp is measured after each increment of the gate pulse base value. A curve of Icp vs base value is
plotted. The maximum Icp value is noted. At this point:

Icp =f* Qss
=f*Ag*q*Dit

where

f: pulse frequency

Qss: recombined charge per pulse period
Ag: channel area of the transistor

qg: electron charge

Dit: interface state density
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Class Exercise

Square Pulse Charge Pumping
1. Recall the Charge Pumping 4T 0.1V step test record.

2. Connect the DUT (MOS FET) as shown in the next
page.

3. Specify the module (SMU and PGU) connected to
DUT terminal properly.

4. Perform the test.

Note:
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Jumper Leads — MOS transistor

N
O @)
s©

O
6
O
12
O O
15 16 17 18
O O O O Su
28 20 21 22 23 15 8
00000000000000] = 1: Substrate
2: Source
 |n@Puooooooooon| 3. Gate
1 1 4: Drain

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145
fixture (16058A) or the newer fixture (16442A/B). Either fixture works fine.

This class exercise requires four jumper leads to connect the DUT. Connect the jumper leads
between the following terminals.

SMUL1 : terminal 1

SMU2 : terminal 2

SMU4 : terminal 4

PGUL1 : terminal 3

Then, the modules must be connected to the fixture as shown below.
B1500A SMUL -> Fixture SMUL1 connector

B1500A SMU2 -> Fixture SMU2 connector

B1500A SMU4 -> Fixture SMU4 connector

B1500A PGL1 -> Fixture PGU1 connector
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Measurement Result Example
¥-¥ Graph Plot Properties___l | Parameters |
£~ Agilent
IepMax 1 93503 na

in
Z 1sn Nss 04187 Tjeme
S 16n
=]

14n

12n

in

300 p
T 60p
2 qop
= wop

Fip

5 45 4 35 3 25 2 45 4 sum 0
YhaseLst () S0 m jidv 4 1+

List Display Properties... | |
Index | \."baseListl I\:pList| i’
1 -5.000000000 Y -72.92000000 pA
2 -4,900000000 Y -70,36000000 p&
2 ASIHOIONT Y. S8 nn0nooph E

Here we see the result of plotting Icp vs pulse base voltage.
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Flash Memory

Basic Flash memory Cell Structure

Vee Erase Write
Control gate d (discharged) (Qf is injected)
vd Floating node
c2
T
c3 Delta Vg
— =rco=FF°¢

Drain Source T Vce
Bulk Voltage for Write/Erase judgment

Effective gate voltage shifts Delta Vg = Qf/Cf.
Of is injected (by a pulse) to Cf is effective floating gate capacitance.
write the memory

Flash memory is one type of floating gate memory. The left figure shows the structure of the floating
gate memory cell. There is a metal floating node on the top of transistor channel region. Any stored
charge in this floating node shifts its threshold voltage as shown in the right figure.
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1 million Write/Erase cycle test

| Initial Write/Erase Test |

Next burst test

(*1) Id(on) and Id(off)
are measured as well.

(*2) 1d(on), Id(off) and
sub-threshold swing (S-
Measure Vth (*2)|  factor) are measured as
well.

Vth (V)

Flash Memory — Endurance Test

—

Write/
Program

Erase

0 1 2 3 4 5 8
10 10 10 10 10 10 10
Cycles

Endurance test is a kind of reliability tests. Repetitive write (program) and erase pulses are applied
to the cell and the Vth of the cell is monitored after certain number of pulses are applied. This test
is important because the flash memory is used for the data and file storage application. Then the
failure rate must be less than one percent for one million write/erase cycles. Therefore, for device
development, the endurance test is the critical test to make sure that the durability of the cell can

meet the target.

When measuring characteristics after certain number of write-erase cycling, Id(on) and Id(off) are
measured besides VVth depending on the cell type. In case of the cell types which use the F-N
tunneling between substrate and floating gate, sub-threshold swing is also measured after erasing

the cell.
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Flash Memory — Endurance Test

e N
NAND Cell Test SPGU output Write pulse
» Burst write/erase reduces [P——
test time dramatically
In an example, the test time was less
than 2 hours for 1 million cycle test. RN,
It will be about 1/70 compared with
4155/4156 solution. 3-level pulse by each channel Erase pulse
. y,
[ NOR Cell Test Write pulses )
. Open
« Drain open can be made by
opening the analog switch in Gate =7
theHVSPGU. [ /vos Bm) Drain 1 d_
For 1 million cycle test, 2PG solution v
improves the test time about 1/4 Source vl
compared with 4155/4156 solution. sub /)
3PG solution improves it about 1/4 /
(_ compared with 2PG solution. Pulse switch for drain open  Erase pulse )

Note:
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NOR Write Connection

Selector or ASU ch2

N
SMU3 Mech
1_@ Mech

Gate

Flash Memory — Endurance Test

Selector or ASU ch3

—

Drain

Solid Mech
State

PG4

Source

‘{ |:| Substrate

Selector or ASU chl

e

Mech

Solid Mech
State

This is an example setup to perform the write operation of the NOR type flash memory cell. This
setup uses three sets of the SMU, SPGU, and selector/ASU. This setup is used by the Demo-S-

NorFlash Endurance test shown in Class Exercise.

To perform the write operation, all of the selector/ASU channels must make the path to the PG.

Note: The solid state relay is installed in the selector, but not installed in the ASU.
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NOR Erase Connection

Selector or ASU ch2

SO
e

Gate

Flash Memory — Endurance Test

Selector or ASU ch3

—

Solid Mech ]
State PG4
Drain
SMU1
Substrate l
Selector or ASU chl
Source
/ SMU2
Mech
Solid Mech @'_l

State

This is an example setup to perform the erase operation of the NOR type flash memory cell. To
perform the erase operation, all of the selector/ASU channels must make the path to the PG and the
PG3 internal pulse switch must be opened. The pulse switch is also a solid state relay.

Note that the solid state relay in the selector is not used. The relay must be always close.
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Flash Memory — Endurance Test

Measure Vth Connection
Selector or ASU ch3

Mech :ISMU4 _l
e
Solid Mech @_1

Selector or ASU ch2 State PG4
Drain

SMU3
_@ . Substrate
1_ Mech

Selector or ASU chl
PG3 Source

Gate
SMU2

/7
Solid Mech @'_l

State PG2

Vth must be measured after writing or erasing. To perform the Vth measurement, all of the
selector/ASU channels must make the path to the SMU. Vth is measured at each decade, so a
mechanical relay will be used, not the solid state relay. The mechanical relay has low leakage
specifications to better match the capabilities of the SMUs.
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Class Exercise

Flash Memory Endurance Test
1.
2.

Recall the Demo-S-NorFlash Endurance test record.

Connect the DUT (MOS FET, not flash memory) as
shown in the next page.

Specify the module (SMU and PGU) connected to
DUT terminal properly.

Perform the test.

To perform this class exercise, you need the following equipment.

16440A Selector with control cable, 2 sets
16445A Selector adapter with control cable, 1 set
B1500A installed with two SPGU modules and four SMU modules

Test fixture

Triaxial cable, 7 ea.
BNC-SMA cable, 3 ea.

Or,

B1500A installed with two SPGU modules, three pairs of HRSMU and ASU, and a SMU module

Test fixture

Triaxial cable, 7 ea.
BNC-SMA cable, 3 ea.
ASU control cable, 3 ea.
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Jumper Leads — MOS transistor

Sub

1: Substrate

2: Source
# nPoooooooooon| 3. Gate
! H 4: Drain

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145
fixture (16058A) or the newer fixture (16442A/B). Either fixture works fine.

This class exercise requires four jumper leads to connect the DUT. Connect the jumper leads
between the following terminals.

SMU1 : terminal 1
SMU2 : terminal 2
SMUS3 : terminal 3
SMU4 : terminal 4

Then, the modules must be connected to the fixture as shown below.

B1500A SMU1 -> Fixture SMU1 connector

B1500A SMU2 -> Selector chl SMU input or ASU chl Force
B1500A SMU3 -> Selector ch2 SMU input or ASU ch2 Force
B1500A SMU4 -> Selector ch3 SMU input or ASU ch3 Force

B1500A PG2 -> Selector chl PGU input or ASU chl AUX In
B1500A PG3 -> Selector ch2 PGU input or ASU ch2 AUX In
B1500A PG4 -> Selector ch3 PGU input or ASU ch3 AUX In

Selector/ASU chl output -> Fixture SMU2 connector
Selector/ASU ch2 output -> Fixture SMU3 connector
Selector/ASU ch3 output -> Fixture SMU4 connector
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Demo-S-NorFlash Endurance Test Setup

TotalWriteAndEraseCycles: |IDDDD ] I

MeasTiming: [m].. |
IntegTime: |MEDIUM vl S e
CG Subs Lol T
Pgate: |SF‘GU3:HV vl | C I Drain: |SMU4:HR vl
Selector
Gate: |SMUZIHR - vd: 100w B
e ° .
o) 5 T
vgStart: [[1.00v B Id@vth: |1E-6%wgfl B
Selector ! ¢ Selector ™!
YgStop: |3.DEI\.‘ EI
: (=] [e)
YgStep: |SD ' El
+ 1} +
Psource: |SPGU2HY = T Subs: |SMU1:HF‘ 'I

suceifzm s V VOV V. VV

See below

For the instrument connection shown in the previous pages, change the value as follows.

Pgate -> SPGU3
Gate -> SMU3

Psource -> SPGU2
Source -> SMU2

Pdrain -> SPGU4
Drain -> SMU4

Subs -> SMU1

Also, set a small TotalWriteAndEraseCycles value, for example 1000. If you set one million, you will have to
wait long time over several hours until the test is completed.

13-31



Module 13
SPGU Control and Applications

| Demo-5-NorFlash Endurance [{2) “NorFlash 100000 Stress Cycle™; 11/3/2007 3:52:09 PM] - Agi i ] o
File Edit View Marker Cursor Line Text Poinker ‘Window Help
R Sy s mmme = = o =
| H-QAQXd-HEEREe @ -F-EEL >
Setup Name: |1 Derno-S-NorFlash Endurance [(2) "NorFlash 100000 Stress Cycle"; 11/3/2007 3:52:09 PM] x
%-Y Graph Plot Properties... | ‘
¥% Agilent
= 14 14 s
= il
E 135 § &
= &
= Write &
13 =
8 =
jid 125
=
I ) ES
— L5 §
= &
5
z Erase
= 105
=]
= 1 1
00 200 300 500 700 Lk 2k 3k Sk 7k 10k 20k 30k S0k 100 k
CycleList decade fdiv
List Display Properties... | ‘
Index | Cyclebist [ wihwirittentist | vithErasadList | i'
ik 100.0000000 1.368200000 1.013700000
2 300.0000000 1.366300000 1.017300000
a3 1.000000000 k 1.364200000 1.021400000 LI

This is a test result example displayed on the Data Display window.
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ALWG Mode

Specify number of repeat for each pattern group.

\
COH & DO Ll Co

Pattern 1 Pattern 2 Pattern N

AN

PG1 Output

Smooth Transition!
No Glitch, No dip to

Pattern 3 Pattern 4 Pattern X

+«———— Must be < (1,024 - # of Patterns) points
for each channel

ALWG stands for Arbitrary Linear Waveform Generator. This function is similar to the AWG (Arbitrary
Waveform Generator), but specialized for a semiconductor parametric test. The ALWG describes the pulse
wave by the combination of the line segment described as the differential time and absolute voltage.

Key features are as follows.
*Number of patterns in a sequence: maximum 512 for a channel

*Number of vector data: maximum 1024-N (N: number of patterns) for defining all patterns to a
channel

*Repeat count of a pattern group: maximum 1,048,576
*Time data (differential time, delta T): 10 ns to 671.088630 ms with 10 ns resolution

*Extremely short over head, 50 ns to change the pattern. No delay for the repetition of the same
pattern.

Of course, +/-40 V and 80 Vpp feature of HYSPGU is available with this ALWG feature.

This function allows you to use more complicated waveform like the multiple level pulse more than 3-level,
and step pulse or ramp voltage to characterize the novel flash memory like CTF.
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ALWG Mode
1. SPGU ALWG Setup Window

Lo 7
 FRFE RIN ~ SEOUENCE COUNT [ []

 DURATION | ifine ALWG Waveform LoE
[ Wit Sintting [ Fie Panern conen |
[Sequence Editar [Pattirns ]

ALWG Source: | 1 1

Insert Column ! | |_n.|'\.ﬂ.|-|.l

- Ti-mtLevel

;los Column No. 1 2
Repeat Count n O |1 i< Count I_LI'I_.I'I.I_I]
Ims-1Vmatiicth
SPGULHVY Ims1v-tange =] a| [1me1vmurie | mle—Pattern

Open /‘ a

This button opens the Pattern Editor D
used to define the arbitrary linear o

waveform. [:|

2. Define ALWG Waveform window

To apply the ALWG output, define the ALWG output sequence, specify the Operation, and click the
Single button.

The following operations are available.

PULSE COUNT: SPGU outputs the specified number of sequences. Specify a number within the
range of 1 to 1000000.

DURATION: SPGU continues the output until the specified time elapses. Specify a time within the
range of 1 us to 31556926 s (1 year).

FREE RUN: SPGU continues the output until the measurement is completed or stopped. This
operation is not available for the SPGU Control classic test.

To define the ALWG output sequence,

1. Open the SPGU ALWG Setup window by clicking the Pulse/ALWG button on the SPGU Control
classic test screen or the SPGU ALWG Setup button on the Measurement Setup screen of the other
classic test.

2. Open the Define ALWG Waveform window by clicking the button of the ALWG Source on the
SPGU ALWG Setup window.

The ALWG output sequence can be defined by specifying the waveform pattern and the repeat count
on the Define ALWG Waveform window. To create a new waveform pattern, use the Pattern Editor.
See the next page.
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ALWG Mode

M

File(F) Edit(E) Display(D)

Undo | Fedo | Add a New Point

Delete a Point

Amplitude(¥)

( 5.000E-3,/0.000EQ )

Time(s)

[3113 " DeltaTime [ DeltaLevel
test
012 No . [Time | Level | Switch
0 D.000D000CED  D.ODDDED 1
o1 1 1 3 000DDED 1
2 2000000003 10000E1 1
- 3 300000000E3 10000E1 1
4 400000000E-3 D.ODDDED 1
/ \ 5 500000000E-3 DO0ODED 1
006

A pattern can be defined by specifying the differential time and the absolute voltage. You can define
it by using the left side GUI or the right side table on the window.
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Class Exercise

output.
3. Save the test setup.

next page.

5. Perform the test.

Monitor ALWG output by the sampling measurement.
1. Click I/V-t Sampling icon and open setup editor.
2. Define the measurement setup with the ALWG

4. Connect a device (511 kohm resistor) as shown in the

Channel Setup:
SMUL1 -> V1, 11, Mode=I
SMU2 -> V2, 12, Mode=COMMON
SPGUL1 -> SPGUV1, Mode=ALWG

Measurement Setup:
Interval=2 ms
No of Samples=201
SMUL1 -> Source=0 A, Compliance=2 VV

Range:
SMU1 -> Mode=FIXED, Range=2 V

ADCl/Integ:
SMUL1 -> ADC=HS ADC

Advanced:
SMU1 -> SMU Filter=OFF

SPGU ALWG Setup:
SPGU1 -> LoadZ=511 kohm

ALWG Source -> Define the waveform as you like.

Display Setup:
X-axis -> Time
Y1-axis -> V1

For the example setup, open the “ALWG monitor” test setup.
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Jumper Leads — Capacitance

SN
FO
O

s©
O O O
L 9 7
Q QR
- % 17 18
e e O O O O
1 2 C1%2820 21 2 23158
@ @ 2 (0000000000000O( 28

N
[ec}

goyooooooooon

14

511 kohm

For all class exercises, you need the 28-pin dual in line socket which comes standard with the 4145
fixture (16058A) or the newer fixture (16442A/B). Either fixture works fine.

This class exercise requires three jumper leads to connect the DUT. Connect the jumper leads
between the following terminals.

SMUL1 : terminal 1

SMU2 : terminal 4

PGUL1 : terminal 1

Then, the modules must be connected to the fixture as shown below.
B1500A SMUL1 -> Fixture SMUL1 connector

B1500A SMU2 -> Fixture SMU2 connector

B1500A PGL1 -> Fixture PGU1 connector
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This is a test result example displayed on the Data Display window for the “ALWG monitor” test
setup.
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